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Legal information
Warning notice system

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent
damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert

symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are
graded according to the degree of danger.

/\DANGER

indicates that death or severe personal injury will result if proper precautions are not taken.

/\WARNING

indicates that death or severe personal injury may result if proper precautions are not taken.

/N\CAUTION

with a safety alert symbol, indicates that minor personal injury can result if proper precautions are not taken.

CAUTION

without a safety alert symbol, indicates that property damage can result if proper precautions are not taken.

NOTICE

indicates that an unintended result or situation can occur if the corresponding information is not taken into
account.

If more than one degree of danger is present, the warning notice representing the highest degree of danger will
be used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to
property damage.

Qualified Personnel

The product/system described in this documentation may be operated only by personnel qualified for the specific
task in accordance with the relevant documentation for the specific task, in particular its warning notices and
safety instructions. Qualified personnel are those who, based on their training and experience, are capable of
identifying risks and avoiding potential hazards when working with these products/systems.

Proper use of Siemens products
Note the following:

/\WARNING

Siemens products may only be used for the applications described in the catalog and in the relevant technical
documentation. If products and components from other manufacturers are used, these must be recommended
or approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and
maintenance are required to ensure that the products operate safely and without any problems. The permissible
ambient conditions must be adhered to. The information in the relevant documentation must be observed.

Trademarks

All names identified by ® are registered trademarks of the Siemens AG. The remaining trademarks in this

publication may be trademarks whose use by third parties for their own purposes could violate the rights of the
owner.

Disclaimer of Liability

We have reviewed the contents of this publication to ensure consistency with the hardware and software
described. Since variance cannot be precluded entirely, we cannot guarantee full consistency. However, the
information in this publication is reviewed regularly and any necessary corrections are included in subsequent

editions.

Siemens AG order number: 6SL3097-4AF00-0BP1 Copyright © Siemens AG 2007,
Industry Sector ® 01/2011 2008, 2009, 2011.

Postfach 48 48 Technical data subject to change
90026 NURNBERG

GERMANY
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SINAMICS documentation

More information

The SINAMICS documentation is organized in the following categories:
® General documentation/catalogs
® User documentation

o Manufacturer/service documentation

The following link provides information on the topics:

® Ordering documentation/overview of documentation

e Additional links to download documents

® Using documentation online (find and search in manuals/information)

http://www.siemens.com/motioncontrol/docu

Please send any questions about the technical documentation (e.g. suggestions for
improvement, corrections) to the following e-mail address:
docu.motioncontrol@siemens.com

My Documentation Manager

Training

FAQs

SINAMICS

Commissioning Manual
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The following link provides information on how to create your own individual documentation
based on Siemens' content, and adapt it for your own machine documentation:

http://www.siemens.com/mdm

The following link provides information on SITRAIN - training from Siemens for products,
systems and automation engineering solutions:

http://www.siemens.com/sitrain

You can find Frequently Asked Questions in the Service&Support pages under Product
Support.

http://support.automation.siemens.com

You can find information on SINAMICS at:

http://www.siemens.com/sinamics.

(IH1), 01/2011, 6SL3097-4AF00-0BP1
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Usage phases and their tools/documents (as an example)

Target group

Benefits

Table 1 Usage phases and the available documents/tools
Usage phase Document/tool
Orientation } SINAMICS S Sales Documentation
Planning/configuration ¢ SIZER Configuration Tool
e Configuration Manuals, Motors
Deciding/ordering SINAMICS S Catalogs
Installation/assembly e SINAMICS S120 Equipment Manual for Control Units and

Additional System Components

o SINAMICS S120 Equipment Manual for Booksize Power
Units

e SINAMICS S120 Equipment Manual for Chassis Power
Units

o SINAMICS S120 Equipment Manual for AC Drives

Commissioning e STARTER commissioning tool

o SINAMICS S120 Getting Started

¢ SINAMICS S120 Commissioning Manual

e SINAMICS S120 CANopen Commissioning Manual
e SINAMICS S120 Function Manual

e SINAMICS S120/S150 List Manual

Usage/operation e SINAMICS S120 Commissioning Manual
e SINAMICS S120/S150 List Manual

Maintenance/servicing e SINAMICS S120 Commissioning Manual
e SINAMICS S120/S150 List Manual

References ¢ SINAMICS S120/S150 List Manual

This documentation is intended for machine manufacturers, commissioning engineers, and
service personnel who use the SINAMICS drive system.

This Manual describes all the information, procedures and operational instructions required
for commissioning and servicing SINAMICS S120.

Commissioning Manual
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Standard scope

The scope of the functionality described in this document may differ from the scope of the
functionality of the drive system that is actually supplied.

® |t may be possible for other functions not described in this documentation to be executed
in the drive system. However, no claim can be made regarding the availability of these
functions when the equipment is first supplied or in the event of servicing.

® Functions that are not available in a particular product version of the drive system may be
described in the documentation. The functionality of the supplied drive system should
only be taken from the ordering documentation.

® Extensions or changes made by the machine manufacturer must be documented by the
machine manufacturer.

For reasons of clarity, this documentation does not contain all of the detailed information on
all of the product types. This documentation cannot take into consideration every
conceivable type of installation, operation and service/maintenance.

Technical Support

Country-specific telephone numbers for technical support are provided in the Internet under
Contact:

http://www.siemens.com/automation/service&support

EC Declaration of Conformity

Notation

Commissioning Manual

Commissioning Manual,

The EC Declaration of Conformity for the EMC Directive can be found on the Internet at:

http://support.automation.siemens.com

There — as a search term — enter the number 15257461 or contact your local Siemens office.

The following notation and abbreviations are used in this documentation:

Notation for parameters (examples):

® p0918 Adjustable parameter 918

® 11024 Visualization parameter 1024

e p1070[1] Adjustable parameter 1070, index 1

® p2098[1].3 Adjustable parameter 2098, index 1, bit 3

e p0099[0...3] Adjustable parameter 99, indices 0 to 3

® r0945[2](3) Visualization parameter 945, index 2 of drive object 3
o p0795.4 Adjustable parameter 795, bit 4

Notation for faults and alarms (examples):
e F12345 Fault 12345
® A67890 Alarm 67890

(IH1), 01/2011, 6SL3097-4AF00-0BP1 5
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ESD Notes

/\CAUTION

Electrostatic sensitive devices (ESD) are single components, integrated circuits or devices
that can be damaged by electrostatic fields or electrostatic discharges.

Regulations for the ESD handling:

During the handling of electronic components, pay attention to the grounding of the person,
workplace and packaging!

Electronic components may be touched by persons only when

o these persons are grounded using an ESD bracelet, or

o these persons in ESD areas with a conducting floor wear ESD shoes or ESD grounding
straps.

Electronic components should be touched only when this is unavoidable. The touching is
permitted only on the front panel or on the circuit board edge.

Electronic components must not be brought into contact with plastics or clothing made of
artificial fibers.

Electronic components may only be placed on conducting surfaces (table with ESD coating,
conducting ESD foamed material, ESD packing bag, ESD transport container).

Electronic components may not be placed near display units, monitors or televisions
(minimum distance from the screen > 10 cm).

Measurements must only be taken on boards when the measuring instrument is grounded
(via protective conductors, for example) or the measuring probe is briefly discharged before
measurements are taken with an isolated measuring device (for example, touching a bare
metal housing).

Commissioning Manual
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Safety notices

Commissioning Manual

ADANGER

Commissioning is absolutely prohibited until it has been completely ensured that the
machine, in which the components described here are to be installed, is in full
compliance with the provisions of the EC Machinery Directive.

SINAMICS devices and AC motors may only be commissioned by suitably qualified
personnel.

The personnel must take into account the information provided in the technical customer
documentation for the product, and be familiar with and observe the specified danger
and warning notices.

When electrical equipment and motors are operated, the electrical circuits automatically
conduct a dangerous voltage.

Dangerous mechanical movements are possible during system operations.

All the work carried out on the electrical machine or system must be carried out with it in
a no-voltage condition.

SINAMICS devices with three-phase motors must only be connected to the power
supply via a universal current-sensitive residual current operated device with selective
switching once it has been verified that the SINAMICS device is compatible with the
residual current operated device in accordance with IEC 61800-5-1.

AWARNING

The successful and safe operation of this equipment and motors is dependent on
professional transport, storage, installation and mounting as well as careful operations ,
service and maintenance.

Information and data from the catalogs and quotations also apply to special versions of
the equipment and motors.

In addition to the danger and warning information provided in the technical customer
documentation, the applicable national, local, and plant-specific regulations and
requirements must be taken into account.

Only protective extra-low voltages (PELV) that comply with EN60204-1 may be
connected to all connections and terminals between 0 and 48 V.

Commissioning Manual, (IH1), 01/2011, 6SL3097-4AF00-0BP1 7
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ACAUTlON

The motors can have surface temperatures of over +80 °C.

e This is why temperature-sensitive components, e.g. cables or electronic components
must not be in contact with or attached to the motor.

o When connecting up cables, please ensure that they
— are not damaged
— are not subject to tensile stress
— cannot be touched by rotating components.

ACAUTION

As part of routine tests, SINAMICS devices with three-phase motors undergo a voltage
test in accordance with IEC 61800. Before the voltage test is performed on the electrical
equipment of industrial machines to EN 60204-1, Section 18.4, all connectors of
SINAMICS devices must be disconnected/withdrawn to prevent the equipment from
being damaged.

e Motors should be connected up according to the circuit diagram provided otherwise they
may be destroyed.

/\CAUTION

Terminals for pulse inhibit (EP terminals)

The Safe Torque Off (STO) safety function must be parameterized in order to use the pulse
inhibit terminals at the Motor Modules, booksize, booksize compact, chassis and Cabinet
Modules and at the Power Modules, chassis and blocksize. (Safety Integrated Basic
Functions or Extended Functions)

Here, the procedure is described in the FHS and FH1 Function Manuals.

Note

When operated in dry areas, SINAMICS devices with three-phase motors conform to Low-
Voltage Directive 2006/95/EC.

Commissioning Manual
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Preparation for commissioning

Before commissioning observe the conditions described in this chapter.

The preconditions for commissioning must be fulfilled (in the next chapter).

The relevant checklist must have been worked through.

The bus components required for communication must be wired up.
DRIVE-CIiQ wiring rules must be adhered to.

ON-OFF responses of the drive

1.1 Requirements for commissioning

The following are necessary for commissioning a SINAMICS S drive system:

STARTER commissioning tool

® An interface, e.g. PROFIBUS, PROFINET, CAN bus or USS (RS232-C)

Completely wired-up drive line-up (see the Manual)

The following diagram shows a sample configuration with booksize and chassis components.

Commissioning Manual
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Preparation for commissioning

1.1 Requirements for commissioning

] L ]
X100 X200 X200
Control Active Single
Unit Line Motor
Module Module
PC/PG
|- . |
\ X126
PROFIBUS
:E
| |
([T
X100 X500 X400 X402 X400
Control Active Active Single
Unit Interface Line Motor
Module Module Module
PC/PG
- X126
|- . |
..
PROFIBUS
| —
Figure 1-1 Component configuration (example)
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Preparation for commissioning
1.2 Check lists to commission SINAMICS S

1.2 Check lists to commission SINAMICS S

Checklist (1) for commissioning booksize power units

The following checklist must be carefully observed. Read the safety instructions in the
Manuals before starting any work.

Table 1- 1 Checklist for commissioning (booksize)

Check OK
Are the environmental conditions in the permissible range?

Is the component firmly attached to the fixing points provided?

Is the specified air flow for cooling the devices ensured?

Have the ventilation clearances for the components been observed?

Is the memory card correctly inserted in the Control Unit?

Are all of the necessary components of the configured drive line-up available, installed
and connected?

Do the temperature monitoring circuits fulfill the specifications of protective
separation?

Have the DRIVE-CLIQ topology rules been observed?

Have the line-side and motor-side power cables been dimensioned and routed in
accordance with the environmental and routing conditions?

Have the maximum permissible cable lengths between the frequency converter and
the motor (depending on the type of cables used) been observed?

Have the power cables been properly connected to the component terminals with the
specified torque?

Have all of the remaining screws been tightened to the specified torque?

Has all wiring work been successfully completed?

Are all connectors correctly plugged in and screwed in place?

Have all the covers for the DC link been closed and latched into place?

Have the screens been correctly connected through a large surface area?
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1.2 Check lists to commission SINAMICS S

Checklist (2) for commissioning chassis power units

The following checklist must be carefully observed. Read the safety instructions in the
Manuals before starting any work.

Table 1- 2 Checklist for commissioning (chassis)

Activity OK
Are the environmental conditions in the permissible range?

Are the components correctly installed in the cabinets?

Is the specified air flow for cooling the devices ensured?

Is an air short-circuit between the air inlet and outlet for the chassis components
prevented by the installation arrangements?

Have the ventilation clearances for the components been observed?

Is the memory card correctly inserted in the Control Unit?

Are all of the necessary components of the configured drive line-up available, installed
and connected?

Do the temperature monitoring circuits fulfill the specifications of protective
separation?

Have the DRIVE-CLIiQ topology rules been observed?

Have the line-side and motor-side power cables been dimensioned and routed in
accordance with the environmental and routing conditions?

Have the maximum permissible cable lengths between the frequency converter and
the motor (depending on the type of cables used) been observed?

Is the ground for the motors directly connected to the ground for the Motor Modules
(shortest distance)?

Are the motors connected with shielded power cables?

Are the power cable shields connected as closely as possible to the terminal box
across a wide area?

Have the power cables been properly connected to the component terminals with the
specified torque?

Have all of the remaining screws been tightened to the specified torque?

Has the total power of the DC busbar been dimensioned sufficiently?

Has the busbar/wiring for the DC connection between the infeed and the Motor
Modules been dimensioned sufficiently with regard to the load and installation
conditions?

Are the cables between the low-voltage switchgear and the power unit protected with
line fuses? Line protection(” should be taken into account.

Have measures been taken to relieve strain on the cables?

For external auxiliary infeed: Have the cables for the auxiliary infeed been connected
according to the Equipment Manual?

Have the control cables been connected in accordance with the required interface
configuration and the shield applied?

Have the digital and analog signals been routed with separate cables?

Has the distance from power cables been observed?

Has the cabinet been properly grounded at the points provided?

Has the connection voltage for the fans in the chassis components been adapted
accordingly to the supply voltages?

Commissioning Manual
16 Commissioning Manual, (IH1), 01/2011, 6SL3097-4AF00-0BP1




Preparation for commissioning
1.2 Check lists to commission SINAMICS S

Activity OK

For operation on non-grounded supply systems: Has the connection bracket for the
interference suppression at the Infeed Module or the Power Module been removed?

Is the period from the date of manufacture to initial commissioning or the downtime of
the power components less than two years@?

Is the drive operated by higher-level controller/control room?

Checklist (3) for commissioning blocksize Power Modules

The following checklist must be carefully observed. Read the safety instructions in the
Manuals before starting any work.

Table 1- 3 Check list for commissioning blocksize

Check OK
Are the environmental conditions in the permissible range?

Is the component firmly attached to the fixing points provided?

Is the specified air flow for cooling the devices ensured?

Have the ventilation clearances for the components been observed?

Is the memory card correctly inserted in the Control Unit?

Are all of the necessary components of the configured drive line-up available, installed
and connected?

Do the temperature monitoring circuits fulfill the specifications of protective
separation?

Have the line-side and motor-side power cables been dimensioned and routed in
accordance with the environmental and routing conditions?

Have the maximum permissible cable lengths between the frequency converter and
the motor (depending on the type of cables used) been observed?

Have the power cables been properly connected to the component terminals with the
specified torque?

Have all of the remaining screws been tightened to the specified torque?

Has all wiring work been successfully completed?

Are all connectors correctly plugged in and screwed in place?

Have the screens been correctly connected through a large surface area?

(M Combined fuses are recommended for conductor and semi-conductor protection
(VDE 636, Part 10 and Part 40 / EN 60269-4). For information about the relevant fuses, see
the catalog.

@If the downtime period is longer than two years, the DC link capacitors must be reformed
(see the "Maintenance and Servicing" chapter in the Equipment Manual). If the device has
been non-operational for less than two years, reforming is not necessary. The cabinet rating
plate can be used to ascertain the date of manufacture.
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1.3 PROFIBUS components

For communication via PROFIBUS, components with a PROFIBUS interface are required.

e A communication module for programming device/PC connection via the PROFIBUS
interface:

® PROFIBUS connection to a programming device/PC via USB port (USB V2.0), e.g. with
the PROFIBUS adapter CP5711.
Structure: USB port (USB V2.0) + adapter with 9-pin SUB-D socket connector to connect
to PROFIBUS.
Used with driver SIMATIC Net PC Software Edition 2008 + SP2
Order No.: 6GK1571-1AA00

Connecting cable

Connecting cable between PROFIBUS adapter and programming device/PC, such as
® Between CP 5xxx and PROFIBUS, Order No.: 6ES7901-4BD00-0XA0

® MPI cable (SIMATIC S7), Order No.: 6ES7901-0BF00-0AAOQ

Cable lengths

Table 1-4  Permissible PROFIBUS cable lengths

Baud rate [bit/s] Max. cable length [m]
9.6 kto 187.5k 1000
500 k 400
1.5M 200
3to12M 100
1.4 PROFINET components

For communication via PROFINET, components with a PROFINET interface are required:

1. A communication module for programming device/PC connection via the PROFINET
interface.
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1.4 PROFINET components

Note

For commissioning with STARTER, the onboard Ethernet interface of the Control Unit can
be used with a crossover cable from CAT5 and higher.

The PROFINET module CBE20 supports all standard Ethernet cables and crossover
cables from CAT5/5e and higher.

2. Connecting cable
Connecting cable between PROFINET adapter and programming device/PC, such as

Industrial Ethernet FC TP Standard Cable GP 2 x 2 (up to max. 100 m)
Standard bus cable with rigid conductors and a special design for fast installation
Order No.: 6XV1840-2AH10

Industrial Ethernet FC TP Flexible Cable GP 2 x 2 (up to max. 85 m)
Order No.: 6XV1870-2B

Industrial Ethernet FC Trailing Cable GP 2 x 2 (up to max. 85 m)
Order No.: 6XV1870-2D

Industrial Ethernet FC Trailing Cable 2 x 2 (up to max. 85 m)

Order No.: 6XV1840-3AH10

Industrial Ethernet FC Marine Cable 2 x 2 (up to max. 85 m)

Order No.: 6XV1840-4AH10

3. Connector
Connector between PROFINET adapter and PG/PC, such as

Commissioning Manual

Industrial Ethernet FC RJ45 Plug 145 for Control Unit
Order No.: 6GK1901-1BB30-0Ax0
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1.5

1.5.1

Rules for wiring with DRIVE-CLIQ

Rules apply for wiring components with DRIVE-CLIiQ. A distinction is made between binding
DRIVE-CLIQ rules, which must be unconditionally observed and recommended rules,
whichshould then be maintained so that the topology, generated offline in STARTER, no
longer has to be changed.

The maximum number of DRIVE-CLiIQ components and the possible wiring type depend on
the following factors:

® The binding DRIVE-CLIQ wiring rules

® The number and type of activated drives and functions on the Control Unit in question
® The computing power of the Control Unit in question

® The set processing and communication cycles

Below you will find the binding wiring rules and some other recommendations as well as a
few sample topologies for DRIVE-CLiQ wiring.

The components used in these examples can be removed, replaced with others or
supplemented. If components are replaced by another type or additional components are
added, the SIZER tool should be used to check the topology.

If the actual topology does not match the topology created offline by STARTER, the offline
topology must be changed accordingly before it is downloaded.

Binding DRIVE-CLIQ rules

DRIVE-CLIQ rules

The wiring rules below apply to standard cycle times (servo 125 us, vector 250 ps). For cycle
times that are shorter than the corresponding standard cycle times, additional restrictions
apply due to the computing power of the Control Unit (configured using the SIZER
configuration tool).

General DRIVE-CLIQ rules

20

The following general binding DRIVE-CLIQ rules must be observed to ensure safe operation
of the drive.

1. A maximum of 14 DRIVE-CLIiQ nodes can be connected to one DRIVE-CLIQ line at a
Control Unit (e. g. 12 U/f axes + Infeed Module + 1 additional module). In the example
below, the DRIVE-CLIQ line includes drive objects 1 to 14.

2. ltis permissible to connect a maximum total of 8 Motor Modules to the Control Unit. For
multi-axis modules, each axis counts individually (1 Double Motor Module = 2 Motor
Modules). Exception: For U/f control it is permissible to connect a maximum of 12 Motor
Modules.

3. With vector U/f control, it is only permissible to connect more than 4 participants to one
DRIVE-CLIQ line of the Control Unit.

4. Ring wiring of components is not permitted.
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1.5 Rules for wiring with DRIVE-CLIQ

5. Double wiring of components is not permitted.

Control
Unit

ring wiring

double wiring

Figure 1-2  Example: DRIVE-CLIQ line connected to the X103 DRIVE-CLiQ connection of a
Control Unit

6. DRIVE-CLiQ components of unknown type within a topology are functionally not
supported. The DRIVE-CLIQ signals are looped through.
The following criteria denote the unknown type:

— Characteristics of the component are not available.
— A deputy drive object is not defined.
— An assignment of the component to a known drive object is not defined.

7. In a DRIVE-CLIQ topology with a CU link and DRIVE-CLIiQ connections, precisely one
Control Unit is permissible as a CU link master/DRIVE-CLiIQ master.

8. If a CU link connection is detected, the DRIVE-CLIiQ basic clock cycle 0 (r0110[0]) is set
to 125 ps and assigned to this DRIVE-CLIQ socket.

9. The following applies for booksize format:

— In the servo control and vector U/f control operating modes, only one Line Module may
be connected to the Control Unit. In the vector control operating mode, a maximum of
three further Line Modules may be connected in parallel (i.e. at total of 4 Line
Modules).

— One Line Module and Motor Modules can be connected to one DRIVE-CLIiQ line in the
servo control mode.

— One Line Module and Motor Modules must be connected to separate DRIVE-CLIQ
lines in the vector control mode.

— For booksize format, a parallel connection of Infeed Modules or Motor Modules is not
possible.

10.The following applies for chassis format:

— Line Modules (Active Line, Basic Line, Smart Line) and Motor Modules must be
connected to separate DRIVE-CLIQ lines.

— Motor Modules with different pulse frequencies (frame sizes FX, GX, HX, JX) must be
connected to separate DRIVE-CLIQ lines.
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.Parallel operation of power units in chassis format:

— A parallel connection of power units is permissible for vector control and U/f control
but not for servo control.

— A maximum of 4 Infeed Modules are permissible within a parallel connection.
— A maximum of 4 Motor Modules are permissible within a parallel connection.

— Only just one parallel connection of Motor Modules is permissible. For a parallel
connection, exactly one drive object ("Servo" or "Vector") is created in the topology.

12.For parallel connection of Motor Modules, only one SINAMICS Sensor Module Integrated

(SMI) is permitted for each Motor Module.

13.Switchover between different motors is not permitted for a parallel connection.

14.Mixed operation of Infeed Modules or Motor Modules:

— The operation of Infeed Modules or Motor Modules with different performance values
is not permitted within a parallel connection.

— For Line Modules in chassis format, two parallel connections are permissible for mixed
operation of Smart Line Modules and Basic Line Modules.

— The following combinations of Line Modules are not permissible:
Active Line Module (ALM) with Basic Line Module (BLM)
Active Line Module (ALM) with Smart Line Module (SLM)

15.Mixed operation of formats:

— Chassis Motor Modules and booksize Motor Modules must be connected to separate
DRIVE-CLIQ lines.

16.Mixed operation of control types:

— Mixed operation of servo control and vector control is not permissible.
— Mixed operation of servo control and U/f control is permissible.

— Mixed operation of vector control and U/f control is permissible.

17.Mixed operation of control cycles:

The following combinations are permissible:
— Servo with 62.5 ys and servo with 125 us
— Servo with 125 us and servo with 250 ps
— Vector with 250 ys and vector with 500 us

18.0peration with Voltage Sensing Module (VSM):

22

— Exactly 1 Voltage Sensing Module (VSM) may be connected to one Line Module.
Exception: If the "Transformer" function module is activated, a second VSM may be
connected.

— A maximum of 2 VSMs may be connected to one Motor Module.

— The VSM must be connected to a free DRIVE-CLiQ socket of the associated Line
Modules/Motor Modules (to support automatic assignment of the VSM).
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1.5 Rules for wiring with DRIVE-CLIQ

19.At a "SERVOQ" or "VECTOR" drive object, the number of connected encoders must be
equal to the number of parameterized encoder data sets (p0140). A maximum of three
encoders are permissible per drive object.
Exception:

— For a maximum quantity structure of 6 axes in servo control with a controller cycle of
125 ps and one Line Module, a maximum of 9 encoders can be connected.

— For 5 axes in servo control with a controller cycle of 125 ps, a maximum of 15
encoders can be connected.

20.A maximum of up to 24 drive objects can be connected.

21.A maximum of 16 Terminal Modules can be connected to the CU320-2.
Note: If a TM15 Base, TM31, TM54F or a TM41 is connected, it is necessary to reduce
the number of connected standard axes.

22.Cycle times with TM31
A maximum of 3 Terminal Modules 31 (TM31) can be connected for a 2 ms time slice.

Note

A Double Motor Module, one DMC20, one DME20, one TM54F and one CUA32 each
correspond to two DRIVE-CLIQ participants. This also applies to Double Motor Modules,
at which just one drive is configured.

23.The communication basic clock cycles (p0115[0] and p4099) of all components that are
connected to a DRIVE-CLIQ line must be divisible by one another with an integer result.

— The smallest communication basic clock cycle is 125 ps.

— The exception are a maximum of 3 servo-controlled axes with 62.5 ys communication
basic clock cycle or a servo-controlled axis with 31.25 ys communication basic clock
cycle.

24 For current controller clock cycles Ti < 125 ps, the Motor Modules - also with the same
controller clock cycle - must be symmetrically connected to two DRIVE-CLiQ ports.

25.The fastest sampling time of a drive object in servo control mode is given as:
— Ti=31.25 ys: Exactly 1 drive object in servo control
— Ti=62.5 ps: Max. 3 drive objects in servo control
— Ti=125 ps: Max. 6 drive objects in servo control
26.The fastest sampling time of a drive object in vector control mode is given as:
— Ti=250 ps: Max. 3 drive objects in vector control
— Ti=400 ps: Max. 5 drive objects in vector control
— Ti=500 ps: Max. 6 drive objects in vector control
27.The fastest sampling time of a drive object in vector U/f vector control mode is given as:

— Ti =500 ps: Max. 12 drive objects in U/f control mode
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28.The maximum number of DRIVE-CLiIQ nodes on a DRIVE-CLIQ line of the Control Unit
depends on the basic clock cycle of the DRIVE-CLIQ line:

For a current controller cycle of 31.25 ps, a maximum of 3 DRIVE-CLiQ nodes are
permissible

For a current controller cycle of 62.5 pys, a maximum of 5 DRIVE-CLIQ nodes are
permissible

For a current controller cycle of 125 us, a maximum of 14 DRIVE-CLiQ nodes are
permissible

For a current controller cycle of 250 us, a maximum of 20 DRIVE-CLiQ nodes are
permissible

For a current controller cycle of 500 ys, a maximum of 30 DRIVE-CLiQ nodes are
permissible

29.Examples for clock cycle level 62.5 ps:

Topology 1: 1 x ALM (250 ps) + 2 x servo (62.5 ps) + 2 x servo (125 pys) + 3 x TM15 +
TM54F + 4 x dbSI2 with encoder S| Motion monitoring clock cycle (p9500) = 12 ms +
S| Motion actual value sensing clock cycle (p9511) = 4 ms + 4 x dir. measuring
systems

Topology 2: 1 x ALM (250 pus) + 2 x servo (62.5 ps) + 2 x U/f (500 us) + 3 x TM15
Base 2 ms +2 x dbSI2 with encoder SI Motion monitoring clock cycle (p9500) = 12 ms
+ Sl Motion actual value sensing clock cycle (p9511) = 4 ms + 2 x dbSI2 sensorless +
2 x dir. measuring systems

Topology 3: 1 x servo (62.5 pys) + 4 x U/f is not possible in connection with Safety
Integrated.

30.Examples for clock cycle level 31.25 ps: 1 x servo (31.25 us)

31.1f the current controller sampling time T at one drive object has to be changed in a
sampling time that does not match the other drive objects in the DRIVE-CLIQ line, the
following solutions are available:

Insert the modified drive object into a separate DRIVE-CLIQ line.

Modify the current controller sampling times and/or the sampling times of the
inputs/outputs of the other drive objects in the same way, so that they match the
modified sampling time again.

32.0nly components that have the same sampling time may be be connected to free DRIVE-
CLiQ connections with a sampling time of Ti = 31.25 ps.
The following components are permissible:

Sensor Modules

High-frequency damping modules (HF damping modules)
Active Line Modules Booksize in the line of the HF filter module.
Smart Line Modules Booksize in the line of the HF filter module.

Additional DRIVE-CLIQ lines must be used for further components:
Further Motor Modules in servo control, in vector control, in U/f control or TMs.
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33.Connection of the following components is not permissible for a sampling time of
Ti=31.25 ps:

— Further Motor Modules in servo control.
— Further Motor Modules in U/f control.
34.Rules for using a TM54F:
— A TM54F must be connected directly to a Control Unit via DRIVE-CLIQ.
— Only one TM54F Terminal Module can be assigned to each Control Unit.

— Additional DRIVE-CLIiQ nodes can be operated at the TM54F, such as Sensor
Modules and Terminal Modules (excluding an additional TM54F).

— Fora CU310-2, no TM54F may be connected to the same DRIVE-CLIQ line as the
Power Module.

35.A maximum of 4 Motor Modules with Safety Extended Functions may be operated on one
DRIVE-CLIQ line (only for Ti= 125 ps). Additional DRIVE-CLiIQ components may not be
connected to this DRIVE-CLIQ line.

36.1f an axis has only one encoder, and if Safety functions are activated for this axis, then
this encoder may be connected to the Motor Module or to the Hub Module DMC20 only.

37.The following applies to the DRIVE-CLiIQ connection of CX/NX components to a Control
Unit:

The connection to the Control Unit is obtained from the PROFIBUS address of the CX/NX
(10 - X100, 11 - X101, 12 -» X102, 13 - X103, 14 - X104, 15 -» X105).

38.1t is not permissible to combine SIMOTION Master Control Units and SINUMERIK Slave
Control Units.

39.1t is not permissible to combine SINUMERIK Master Control Units and SIMOTION Slave
Control Units.

Note

To enable the function "Automatic configuration" to assign the encoders to the drives, the
recommended rules below must also be observed.

15.2 Recommended DRIVE-CLIQ rules

Recommended DRIVE-CLIQ rules

1. The following applies to all DRIVE-CLiQ components with the exception of the Control
Unit: The DRIVE-CLIQ sockets Xx00 are DRIVE-CIiQ inputs, the other DRIVE-CLIQ
sockets are outputs.
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2. Asingle Line Module should be connected directly to the X100 DRIVE-CLIiQ socket of the
Control Unit.

— Several Line Modules should be connected in a line.

— If the X100 DRIVE-CLIiQ socket is not available, the next higher DRIVE-CLIQ socket
should be used.

3. For a current controller cycle of 31.25 ps, a filter module should be directly connected to a
DRIVE-CLIQ socket of the Control Unit.

4. For the chassis format, Motor Modules with a current controller cycle of 250 ys should be
connected to DRIVE-CLIQ socket X101 of the Control Unit. If required, they should be
connected in a line.

— If the DRIVE-CLIQ socket X101 is not available, the next higher DRIVE-CLIQ socket
should be used for these Motor Modules.

5. For the chassis format, Motor Modules with a current controller cycle of 400 ps should be
connected to DRIVE-CLIQ socket X102 of the Control Unit. If required, they should be
connected in a line.

— If the DRIVE-CLIiQ socket X102 is not available, the next higher DRIVE-CLIQ socket
should be used for these Motor Modules.

6. For the chassis format, the Line Module and the Motor Modules should be connected to
separate DRIVE-CLIQ lines.

7. Peripheral components (e.g. Terminal Module, TM) should be connected to DRIVE-CLIQ
socket X103 of the Control Unit in a line.

— If the DRIVE-CLIQ socket X103 is not available, any free DRIVE-CLiQ socket should
be selected for the peripheral components.

8. For the booksize format, the Motor Modules in servo control mode should be connected
in line to DRIVE-CLIiQ socket X100 of the Control Unit.

— If the DRIVE-CLIQ socket X100 is not available, the next higher DRIVE-CLIQ socket
should be used for these Motor Modules.

9. The motor encoders for the first drive of a Double Motor Module should be connected to
the associated DRIVE-CLIQ socket X202.

10.The motor encoders for the second drive of a Double Motor Module should be connected
to the associated DRIVE-CLiQ socket X203.
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11.The motor encoder should be connected to the associated Motor Module:
Connecting the motor encoder via DRIVE-CLIQ:

— Single Motor Module Booksize to terminal X202

— Double Motor Module Booksize motor X1 to terminal X202 and motor X2 to terminal
X203

— Single Motor Module Chassis to terminal X402
— Power Module Blocksize with CUA31: Encoder to terminal X202
— Power Module Blocksize with CUA31: Encoder to terminal X100 or via TM31 to X501

— Power Module Chassis to terminal X402

Note

If an additional encoder is connected to a Motor Module, it is assigned to this drive as
encoder 2 in the automatic configuration.

12.DRIVE-CLIQ sockets should, as far as possible, be symmetrically wired.
Example: Do not connect 8 DRIVE-CLIQ nodes in series at one DRIVE-CLiQ socket of
the CU - but instead, connect 2 nodes at each of the 4 DRIVE-CLiQ sockets.

13.The DRIVE-CLIiQ cable from the Control Unit should be connected to DRIVE-CLIQ socket
X200 on the first booksize power unit or X400 on the first chassis power unit.

14.The DRIVE-CLIiQ connections between the power units should each be connected from
the DRIVE-CLIQ sockets X201 to X200 and/or X401 to X400 on the follow-on component.

15.A Power Module with the CUA31 should be connected to the end of the DRIVE-CLIiQ line.

Control Single Double Single Power Module
Unit Motor Motor Motor Blocksize
— Module Module Module
X103
| —] — — —
X102 X202/X402 X203 X202/X402 CUA31
— =  — = —
X101 X201/X401 X202 X201/X401 X202
ﬁ =1 = =7 —_
0 X2007X400 X201 X2007X400 X201
=] =1
X200 X200

Figure 1-3  Example: DRIVE-CLIQ line

16.0nly one final node should be connected to free DRIVE-CLIiQ sockets of components
within a DRIVE-CLIQ line (e.g. Motor Modules wired in series), for example, one Sensor
Module or one Terminal Module, without routing to additional components.

17.1f possible, Terminal Modules and Sensor Modules of direct measuring systems should
not be connected to the DRIVE-CLIQ line of Motor Modules, but rather, to free DRIVE-
CLiQ sockets of the Control Unit.
Note: This restriction does not apply to star-type connections.

18.The TM54F should not be operated on the same DRIVE-CLIiQ line as Motor Modules.
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19.The Terminal Modules TM15, TM17 and TM41 have faster sample cycles than the TM31
and TM54F. For this reason, the two Terminal Module groups should be connected to
separate DRIVE-CLIQ lines.

20.For mixed operation of the servo control and vector U/f control operating modes, separate
DRIVE-CLIQ lines should be used for the Motor Modules.

— Mixed operation of operating modes is not possible on a Double Motor Module.

21.The Voltage Sensing Module (VSM) should be connected to the DRIVE-CLIQ socket
X202 (Booksize format) or X402 (Chassis format) of the Line Module.

— If the X202/X402 DRIVE-CLIiQ sockets are not available, a free DRIVE-CLiQ socket of
the Line Module should be used.

Control Active Single
Unit Line Motor
= Module Module
X103
 m— = =  m—
X102 X202/X402 X500 X202/X402
= — =——-1
X101 X201/X401 X201/X401
= =] =]
X100 X200/X400] X200/X400
VSM
[¢]

Figure 1-4  Example of a topology with VSM for booksize and chassis components

Table 1-5 VSM connection

Component VSM connection

Active Line Module booksize X202

Active Line Module chassis X402

Power Module chassis X402

Motor Module Chassis X402 (active with PEM encoderless and "Flying restart"
function)
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1.6.3 Wiring example for drives in vector control mode

Example 1

1.5 Rules for wiring with DRIVE-CLIQ

A drive line-up with three Motor Modules in chassis format with identical pulse frequencies or
three Motor Modules in booksize format in vector control mode:

The Motor Modules Chassis with identical pulse frequencies or the Motor Modules Booksize
in vector control mode can be connected to one DRIVE-CLIQ interface on the Control Unit.

In the following diagram, three Motor Modules are connected to the DRIVE-CLIQ socket

X101.

Note

This topology does not match the topology created offline by STARTER and must be
changed manually.

Infeed 1 Drive 1 Drive 2 Drive 3
Control Active Single Single Single
Unit Line Motor Motor Motor
= Module Module Module Module
X103
 — = = = =
X102 X402 X402 X402 X402
=  — = = c
X101 X401 X401 L X401 L X401
= =] =1 —== —
X100 X400 X400 X400 X400
o —o —o —o
[ [ [
Active | X|5?0 | X%O | X%O
Interface O— - 0— - O— -
Module || xs20 K || X520 L || xo20 1
= smc || smc |! smc ||
[ 30 Ji | s Ji f| =0 i
! | i
v | ey ey ey
L —eo L —eo L —e
M M M
Figure 1-5  Drive line-up (chassis) with identical pulse frequencies

Commissioning Manual

Commissioning Manual, (IH1), 01/2011, 6SL3097-4AF00-0BP1

—=——— DRIVE-CLIQ
0 — - — Encoder
e— —— Power

29



Preparation for commissioning

1.5 Rules for wiring with DRIVE-CLIQ

Drive line-up comprising four Motor Modules in chassis format with different pulse frequencies

Motor Modules with different pulse frequencies must be connected to different DRIVE-CLIQ
sockets on the Control Unit.

In the following diagram, two Motor Modules (400 V, output < 250 kW, pulse frequency
2 kHz) are connected to interface X101 and two Motor Modules (400 V, output > 250 kW,
pulse frequency 1.25 kHz) are connected to interface X102.

Note

This topology does not match the topology created offline by STARTER and must be
changed manually.

Drive 1 Drive 2 Drive 3 Drive 4
Single Single Single Single
Motor Motor Motor Motor
Module Module Module Module
X%Z X%Z X402 X402
= —_
X401 L X401 X401 \ X401
=1 — == =1 =
X400 X400 X400 X400
—0 —0 —0 —o
[ | | |
|| x50 || o || o || o
X500 X500 X500 X500
O— - —I O— - —I O— - —I O— - —I
| x520 | ! | X520 |! | X520 | X520
smc || smc || smc || smc ||
[ 30 i ] 80 i ] s i || a0 |
| | | i
N e M R
L —o - —o L —o L —o
M M M M
—=——— DRIVE-CLIQ

v v o — - — Encoder
e— —— Power

Drive line-up in chassis format with different pulse frequencies

Infeed 1
Control Active
Unit Line
Module
X103
—= =
X102 X402
—= —_
X101 X401
= =1
X100 X400
o
Active
Interface
Module
=
X500
VSM
Figure 1-6
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Preparation for commissioning

1.5 Rules for wiring with DRIVE-CLIQ

1.54 Wiring example for parallel connection of Motor Modules in vector control mode

Drive line-up with two parallel-connected Line Modules and Motor Modules in chassis format of the

same type

Parallel-connected Line Modules in chassis format and Motor Modules in chassis format of
the same type can be connected to a DRIVE-CLIiQ socket of the Control Unit.

In the following diagram, two Active Line Modules and two Motor Modules are connected to

the X100 or X101 socket.

For further information on parallel connection, see the chapter "Parallel connection of power
units" in the SINAMICS S120 Function Manual.

Note

This topology does not match the topology created offline by STARTER and must be
changed manually.

Infeed 1
Control Active Active
Unit Line Line
= Module Module
X103
—

X102 X402 X402
—= = —_
X101 X401 X401
—= =3 =
X100 X400 X400

o o
Active Active
Interface Interface
Module Module
—= —3
X500 X500
VSM VSM
Figure 1-7
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Drive 1
Single Single
Motor Motor
Module Module
= —
X402 X402
X401 L X401
X%IO X400
i ?
I ]
| | &0 | |
X500
AN
| smc
| | 30 |
| [P —— [E—
M

N

—=——— DRIVE-CLIQ
0 — - — Encoder
©— — Power

Drive line-up with parallel-connected power units in chassis format
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Preparation for commissioning

1.5 Rules for wiring with DRIVE-CLIQ

1.5.5

Blocksize

Sample wiring: Power Modules

DRIVE-CLIQ

Power Module 340

Blocksize

D

X100

Control
Unit

E|x124

Motor cable

Encoder
cable

DRIVE-CLIQ

X100
Control

Unit
Adapter

H X124

Power Module 340
Blocksize

D

Motor cable

DRIVE-CLIQ

X500
SMC20

X520[ ]
1

D
I

&)
I

Encoder cable

Figure 1-8
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Wiring example for Power Modules Blocksize
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Preparation for commissioning

Chassis

1.5 Rules for wiring with DRIVE-CLIQ

DRIVE-CLiQ

{111

T

X100

Control
Unit

H X124

Figure 1-9
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Power Module Chassis

X500 X500
SMC20| TM31

X520[])

Q. |D
I

Motor cable Encoder cable

Wiring example for Power Modules Chassis
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Preparation for commissioning

1.5 Rules for wiring with DRIVE-CLIQ

1.5.6

Changing the offline topology in STARTER

The device topology can be changed in STARTER by moving the components in the
topology tree.

Table 1- 6

Example: changing the DRIVE-CLIQ topology

Topology tree view

Remark

= fla SINAMICS_S120_CU320
L Overview
» Configuration

Topology tree |

Bl <Control_Unit (1)

= [THTY Infeed.Infeed (2)

Free

Select the DRIVE-CLiIQ component.

Topaology tree I

Bl Control_Unit (1)

= [CHOpY Infeed Infeed (2)

=[O Drive_1,Fower_unit (3)
o Free
-[ZHo[ Drive_1.5M_to_Encoder_1
Free
o]l 551 3120- ITE13-0Axx (3)
Free
Free
Free

Keeping the mouse button depressed,
drag the component to the required
DRIVE-CLIQ interface and release the
mouse button.

Topalogy tree |

Bl Control_Unit (1)
= [EHOp nfeed.Infeed (2}

E[_ Free

e ] Free
ive_ 1. FPower_unit (3)

Free

- [ZH O[] Dirive_1.5M_to_Encoder_1 {4)

You have changed the topology in
STARTER.
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Preparation for commissioning

1.5 Rules for wiring with DRIVE-CLIQ

1.5.7 Offline correction of the reference topology

Description

The topology is based on a modular machine concept. The machine concept is created
"Offline" in STARTER in the maximum version as reference topology.

The maximum version is the maximum expansion of a particular machine type. In the
maximum version, all the machine components that can be used are pre-configured in the
reference topology.

Deactivate components and does not exist

In a lower expansion stage of the machine, in the reference topology, you must select the
drive objects and encoder not used in the actual topology. To do this, for the corresponding
drive objects and encoder, set parameter p0105 or p0145 = 2 (deactivate component and
does not exist). Components set to the value "2" in a project generated offline must never be
inserted in the actual topology at all.

If a component fails, the sub-topology can also be used to allow a machine to continue to
operate until the spare part is available. In this case, however, no BICO source must be
interconnected from this drive object to other drive objects.

Example of a sub-topology

Commissioning Manual

Commissioning Manual

The starting point is a machine created "offline" in STARTER. "Drive 1" was not implemented
for this machine.

® You can remove drive object "Drive 1" "offline" from the reference topology using p0105 =
2.

® Change over the DRIVE-CLIiQ cable from the Control Unit directly to "Drive 2".
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Preparation for commissioning

1.5 Rules for wiring with DRIVE-CLIQ

e Transfer the project with "Download to drive unit".

® Then execute a "Copy RAM to ROM".

Infeed 1 Drive 1 Drive 2
CU320-2 Active Single Single
Line Motor Motor
[ Module Module Module
XgZ ng XgZ Xé]IZ
X101 X401 X401 | | x401
X100 X400 X400 X400
Setpoint
o —f) —f)
topology |' |'
. = =
Inpt\g:]');ie | X500 | X500
Oe= - 4 Do - 4
Module || xs20 K || xs20 K
= smc || smc ||
X500 [l 30 [ || 30 |
i |
VSM | i | i
e e | o
M M
Infeed 1 Drive 2
CU320-2 Active Single
Line Motor
[ Module Module
X|1__(_)|2 XgZ XgZ
X101 X401 reconnected X401
= =3
X100 X400 X400
Partial o —
topology [
. =
Active I X500
Interface o—-1
Module | X520 |V
= smc ||
X500 | 30 I
VS
VSM
L —o
M

Figure 1-10 Example of a sub-topology

—=—— DRIVE-CLIQ
o — - — Encoder

@= = Power

/\ CAUTION
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Preparation for commissioning

1.5 Rules for wiring with DRIVE-CLIQ

If a drive in a Safety Integrated drive line-up is deactivated using p0105, then r9774 is

not correctly output because the signals of the deactivated drive are no longer updated.

Remedy: Before deactivating, take this drive out of the group. See also: SINAMICS

S120 Safety Integrated Function Manual

Activating/deactivating components

Drive objects can be activated/deactivated using parameter p0105 and encoders with
p0145[0...n] in the Expert list in the same way. If a component is not required at certain
times, then change the component parameters p0105 or p0145 from "1" to "0". The
deactivated components remain inserted, however, they are deactivated. Errors are not

displayed from deactivated components.

Overview of important parameters (see SINAMICS S120/S150 List Manual)

Commissioning Manual

p0105 Activate/deactivate drive object

r0106 Drive object active/inactive

p0125 Activate/deactivate power unit component

r0126 Power unit component active/inactive

p0145[0...n] activate/deactivate encoder interface

r0146 Encoder interface active/inactive

p9495 BICO response to deactivated drive objects

p9496 Re-establish BICO to the now activated drive objects
r9498[0...29] BICO BI/CI parameter for deactivated drive objects
r9499[0...29] BICO BO/CO parameter for deactivated drive objects
r9774.0...31 CO/BO: Sl Status (group STO)

Commissioning Manual, (IH1), 01/2011, 6SL3097-4AF00-0BP1
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Preparation for commissioning

1.5 Rules for wiring with DRIVE-CLIQ

1.5.8 Sample wiring for servo drives

The following diagram shows the maximum number of controllable servo drives and extra
components. The sampling times of individual system components are:

e Active Line Module: p0115[0] = 250 ps
® Motor Modules: p0115[0] = 125 us

® Terminal Module/Terminal Board p4099 = 1 ms

l)%m'—“ SMy SMx SMx SMx SMx SMx SMx
g |
X500
TMX X500 X500 X500 X500 X500 X500 X500
—t—1 — — — [ —  —  —
Control SMM SMM DMM SMM SMM
Unit
ni Sy
X103 X203
—
X102 X500 X202 X202 X202 X202 X202
— — — [ — [ — — [ m—
X101 X201 X201 X201 X201 X201
[ — [ m— — — ——
X100 | | X200 | X200 | X200 )% | )%
ALM SMy
X500
—t——1
X202
—
X201
—
X200
—
Figure 1-11  Sample servo topology
Legend for topology example:
ALM = Active Line Module
SMM = Single Motor Module
DMM = Double Motor Module
SMx = Motor encoder
SMy = Direct measuring system
TMx = TM31, TM15DI/DO, TB30
Commissioning Manual
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Preparation for commissioning
1.5 Rules for wiring with DRIVE-CLIQ

1.5.9 Sample wiring for vector V/f drives
The following diagram shows the maximum number of controllable vector V/f drives with
additional components. The sampling times of individual system components are:
® Active Line Module: p0115[0] = 250 ps
® Motor Modules: p0115[0] = 125 us
® Terminal Module/Terminal Board p4099 = 1 ms
® Max. 12 axes can be controlled in V/f mode
—_
X501
=
X500
TMx SMM SMM SMM SMM
CU320
X202 X202 X202 X202
— —_ — —
X103 X201 X201 X201 g
o=
X100
=
ALM SMM SMM SMM SMM
X202 X202 X202 X202 X202
— — — — o |
= (- - (= - = ALM = Active Line Module
= = _|——X2£| _l = _l = SMM = Single Motor Module
TMx = TM31, TM15DI/DO

Figure 1-12  Sample topology for vector V/f control

1.5.10 Notes on the number of controllable drives

The number and type of controlled axes and the extra activated functions of the project can
be scaled by configuring the firmware. Especially for demanding configurations, drives with
high dynamics or a large number of axes with additional utilization of special functions for

example, a check using the SIZER configuration tool is recommended. The SIZER
calculates the feasibility of the project.

The maximum possible functionality depends on the performance of the Control Unit used
and the components configured.

Commissioning Manual
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Preparation for commissioning

1.5 Rules for wiring with DRIVE-CLIQ

1.5.10.1

System sampling times and number of controllable drives

This chapter contains a list of the axes that can be operated with SINAMICS S120
depending on the cycle times in the various control modes. The other available remaining
computation times are available for options (e.g. DCC).

Cycle times for the "servo" control mode

The following table shows the number of axes that can be operated depending on the

selected cycle times in the "servo" control mode:

Table 1-7 Sampling time setting for servo
Cycle times [us] Number Motor / dir. TMY/TB
Current Speed controller Axes Infeed measuring
controller systems
125 125 6 1 [250 ps] 6/6 32000 ps]
62.5 62.5 3 1 [250 ps] 3/3 3[2000 ps]
31.252 31.252 1 1 [250 ps] 1/1 3[2000 ps]

sampling time.

2) In the clock cycle level 31.25 ys you can additionally set-up the following objects:
- 1 servo axis with a sampling time of 125 ps
- 2 U/f axes with a sampling time of 500 ps

1) Valid for TM31 or TM15I0O; for TM54F, TM41, TM15, TM17, TM120 - restrictions are possible dependent on the set

40

The following combinations are permissible for current controller cycle mixed operation:

® Servo with 125 us and servo with 250 ps (only 2 clock cycle levels may be mixed)

® Servo with 62.5 us and servo with 125 s (only 2 clock cycle levels may be mixed)

Note the following: 1 axis with 31.25 us corresponds to

® 2 servo axes with 62.5 us
® 4 servo axes with 125 us
e 8 U/f axes with 500 us

Commissioning Manual

Commissioning Manual, (IH1), 01/2011, 6SL3097-4AF00-0BP1




Preparation for commissioning

1.5 Rules for wiring with DRIVE-CLIQ

Cycle times in the "vector" control mode

The following table shows the number of axes that can be operated depending on the
selected cycle times in the "vector" control mode:

Table 1- 8 Sampling time setting for vector

Cycle times [ps] Number Motor / dir. ™Y/ TB
Current Speed controller Axes Infeed? measuring
controller systems
500 2000 6 1 [250 ps] 6/6 3 [2000 ps]
4009 1600 5 1 [250 ps] 5/5 3[2000 ps]
250 1000 3 1[250 ps] 3/3 32000 ps]

1) Valid for TM31 or TM15I0; for TM54F, TM41, TM15, TM17, TM120 - restrictions are possible dependent on the set
sampling time.

2) For power units in chassis format, the infeed cycle depends on the power rating of the module and can assume values
of 400 ys, 375 ps or 250 ps.

3) This setting results in lower remaining computation times.

The following combination is permissible in current controller cycle mixed operation:

e Vector with 250 ys and vector with 500 ps

NOTICE

Restriction for chassis format in the case of special functions

If edge modulation and wobbling are activated simultaneously with p1802 = 7 and
p1810.2 = 1 respectively, the quantity structure for vector control is halved. Then, for
example, a maximum of 3 axes at a current control cycle of 500 ps, 2 axes at 400 ps or
1 axis at 250 ps are possible.

Commissioning Manual
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1.5 Rules for wiring with DRIVE-CLIQ

Cycle times in the "Vector U/f" control mode

The following table shows the number of axes that can be operated depending on the
selected cycle times in the "Vector U/f" control mode:

Table 1- 9 Sampling time setting for vector U/f

Cycle times [us] Number Motor / dir. TM/TB
Current Speed controller Drives / Infeed measuring
controller systems
500 2000 12 1 [250 ps] -/ - 3 [2000 ps]

Mixed operation of the "Servo" and "Vector U/f* control modes

In mixed "Servo" with "Vector U/f control" operation, one axis with servo control is considered
to be two axes in U/f control mode.

Table 1-10  Number of axes for mixed operation of servo controller and U/f control

Number of axes in servo control Number of axes in U/f control

6 125 ps 3 62.5 us 0

5 125 us 2 500 ps
4 125 s 2 62.5 ps 4 500 ps
3 125 ps 6 500 ps
2 125 ps 1 62.5 us 8 500 ps
1 125 us 10 500 ps
0 0 12 500 ps

Mixed operation of the "Vector" and "Vector U/f* operating modes

In mixed "Vector" with "Vector U/f control" operation, one axis in vector control is considered
to be two axes in U/f control mode. A maximum of 6 axes are permitted in conjunction with
vector control.

Table 1- 11  Number of axes for mixed operation of vector controller and U/f control

Number of axes in vector control Number of axes in U/f control

6 250 ps 0

5 250 us 1 500 ps
4 250 us 2 500 ps
3 250 ps 3 500 ps
2 250 ps 4 500 ps
1 250 us 5 500 ps
0 12 500 ps
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1.5 Rules for wiring with DRIVE-CLIQ

Using DCC

The available remaining computation time can be used for DCC. In this case, the following
supplementary conditions apply:

® For a2 ms time slice, a max. of 75 DCC blocks can be configured for each servo axis
with 125 ps that can be omitted/eliminated (2 2 U/f axes with 500 pus).

e 75 DCC blocks for 2 ms time slice correspond to 2 U/f axes with 500 ps.
® 50 DCC blocks for 2 ms time slice correspond to 1.5 U/f axes with 500 ps.

Using EPOS

The following table shows the number of axes that can be operated depending on the
selected cycle times

Table 1- 12 Sampling times when using EPOS

Cycle times [us] Number
Current controller Speed controller Axes Infeed
250 250 6 1 [250 ps]
250 250 5 1 [250 ps]
125 125 4 1 [250 ps]

The use of an EPOS function module (with 1 ms position controller/4 ms positioner)
corresponds to 0.5 U/f axes with 500 ps.

Using CUA31/CUA32
Information on using the Control Unit Adapter CUA31 or CUA32:
® CUAB31/32 is the first component in the CUA31/32 topology: 5 axes
o CUAS31/32 is not the first component in the CUA31/32 topology: 6 axes

® For a current controller cycle of 62.5 us, only 1 axis is possible with one CUA31/32.

Commissioning Manual
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1.5 Rules for wiring with DRIVE-CLIQ

1.5.10.2 Optimizing DRIVE-CLIQ

Symmetrical distribution for the controller clock cycles 62.5 ys and 31.25 ps

For faster computation times of the master Control Unit, the axes must be distributed across
the DRIVE-CLIiQ connections as follows:

e DRIVE-CLIQ socket X100: Infeed, axes 2, 4, 6, ...
e DRIVE-CLIQ socket X101: Axes 1, 3, 5, ...
Axes 1, 2, 3, 4, 5, 6, ... this should indicate the sequence of the drive controllers.

The advantage of this arrangement is that the Control Unit always receives 2 measured
values simultaneously.

Commissioning Manual
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Preparation for commissioning

1.5 Rules for wiring with DRIVE-CLIQ

1.5.10.3 Default settings for the sampling times

When commissioning for the first time, the current controller sampling times (p0115[0]) are
automatically pre-set with factory setting values:

Table 1- 13  Factory settings

Construction type Number p0112 p0115[0] | p1800

Active Infeed and Smart Infeed
Booksize 1 2 (Low) 250 ps -
Chassis 1 2 (Low) 250 ps -
400 V /< 300 kW
690 V /< 330 kW
Chassis 1 0 (Expert) 375 ps (p0092 = 1) -
400 V /> 300 kW 1 (xLow) 400 s (p0092 = 0) -
690 V /> 330 kW
Basic Infeed
Booksize 1 4 (High) 250 ps -
Chassis 1 3 (Standard) 2000 ps -
Servo
Booksize 1t0 6 3 (Standard) 125 ps 4 kHz
Chassis 1t06 1 (xLow) 250 ps 2 kHz
Blocksize 1to5 3 (Standard) 125 ps 4 kHz
Vector
Booksize 1 to 3 only n_ctrl 3 (Standard) 250 ps 4 kHz
Chassis 1to 6 only U/f 2 kHz
400 V / < 250 kW
Booksize 4 to 6 only n_ctrl 0 (Expert) 500 ps 4 kHz
Chassis 7to12 onIy U/f 2 kHz
400 V / < 250 kW
Chassis 1 to 4 only n_ctrl 0 (Expert) 375 ps (p0092 = 1) 1.333 kHz
> 250 kW 1 to 5 only U/f 1 (xLow) 400 ps (p0092 = 0) 1.25 kHz
690 V 1 to 6 only n_ctrl 0 (Expert) 500 ps (p0092 = 1) 2 kHz
Booksize > 6 only U/f 0 (Expert) 500 ps 4 kHz
Chassis 2 kHz
Blocksize 1 to 3 only n_ctrl 3 (Standard) 250 ps 4 kHz

1 to 6 only U/f

> 3 n_ctrl (min. 1) 0 (Expert) 500 ps 4 kHz

> 6 only U/f
Caution
If a Power Module in blocksize format is connected to a Control Unit, the sampling times of all vector drives are set
according to the rules for Power Modules in blocksize format (only 250 ps or 500 us possible).
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Preparation for commissioning

1.6 Powering-up/powering-down the drive system

1.6 Powering-up/powering-down the

Powering up the infeed

POWER ON

v

S1 : Closing lockout

<1>ZSWA.06 =1
ZSWA.00/01/02/11 =0

v

"Commissioning ready"
(p0010 = 0 and p0009 = 0) —
"0 = OFF1" (STWAE.00) —Q
"0 = OFF2" (STWAE.01) —
24V at EP terminals —
Motor Module <3>

<1>

v

S2: Ready to start
ZSWA.00 =1,

ZSWA.01/02/06 =0

- Main contactor open
- Wait for switch-on

v

"0 = AUST" —

&

p0862

<1>

S3: Ready
SWA.00/01 =1, 19
SWA.02/06/11 =0 <2>

Line contactor is CLOSED
Wait for pre-charging

Z
Z

<1>

"Enable operation" (STWA.03) p3490

&

<1>

( S4: operation
ZSWAE.00/01 =1
ZSWAE.02/06/11 =0
tF‘ulses enabled
- Controller enabled

)

"0 = AUS1"—(Q

Eﬁ\j

drive system

ST

Open
line contactor

S6
Open
line contactor

A

"0 = OFF2" —Q

-

&

Figure 1-13  Powering up the infeed
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<1> STWA.xx = control word sequence control bit xx (r0898);

ZSWA .xx = status word sequence control bit xx (r0899).
<2>r0002 = operating display
<3> only required, if "Safe Torque Off (STO)" safety function is activated
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Powering up the drive

POWER ON

S1 : Closing lockout

<1>ZSWA.06 =1
ZSWA.00/01/02/11 =0

Drive at standstill

3x
<2>

"Commissioning ready" v
(p0010 =0 and p0009 =0) —
"0 = OFF1" (STWA.00) <—>C
"0 = OFF2" (STWA.01) —
"0 = OFF3" (STWA.02) —

24 V at EP terminals —

Pulse enable HW
[FP2701.8] [FP2711.8]

&

S5b: Quick stop

ZSWA.00/01 =1, ZSWA.11
ZSWA.02/06 =0

)

Preparation for commissioning
1.6 Powering-up/powering-down the drive system

Drive via fast stop ramp
or torque limitton=0

travel, then disable pulses J

:

Motor Module <3> <1>

S2: Ready to start
ZSWA.00 =1,
ZSWA.11=0
- Line contactor is OPEN
- Wait for switch-on

"0= AUS1"£

21

<2>|

5

Infeed ready &
p0864 Pulse enable HW &
[FP2701.8]
from Line Module or INFEED %
(r0863.0) 33: Read
ZSWA.00/01 =1, 19
ZSWA.02/06/11 =0 <2> S5a: Ramp stop

ZSWA.00/01 =1
ZSWA11 =1
ZSWA.02/06 =0

Line contactor is CLOSED
Wait for pre-charging

"Enable operation" (STWA.03)
"Ready" from Motor Module (r0863.0)

— 1

Demagnetization completed &
(r0046.27 = 0)
o=Aust"—d &
¢ <1>
S4: operation
ZSWA.00/01 =1
ZSWA11 =1 00
ZSWA.06 =0 <2>

Pulses enabled
Controller enabled

L

<1> STWA .xx = control word sequence control bit xx (r0898);

ZSWA .xx = status word sequence control bit xx (r0899)
<2>r0002 = operating display
<3> only required, if "Safe Torque Off (STO)" safety function is activated

Figure 1-14  Powering up the drive
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1.6 Powering-up/powering-down the drive system

Off responses
e OFF1
— n_set = 0 is input immediately to brake the drive along the deceleration ramp (p1121).

— When zero speed is detected, the motor holding brake (if parameterized) is closed
(p1215). The pulses are suppressed when the brake application time (p1217) expires.
Zero speed is detected if the actual speed drops below the threshold (p1226) or if the
monitoring time (p1227) started when the speed setpoint < speed threshold (p1226)
has expired.

e OFF2
— Instantaneous pulse suppression, the drive "coasts" to a standstill.
— The motor holding brake (if parameterized) is closed immediately.
— Switching on inhibited is activated.

e OFF3

— n_set=0 is input immediately to brake the drive along the OFF3 deceleration ramp
(p1135).

— When zero speed is detected, the motor holding brake (if parameterized) is closed.
The pulses are suppressed when the brake application time (p1217) expires. Zero
speed is detected if the actual speed drops below the threshold (p1226) or if the
monitoring time (p1227) started when the speed setpoint < speed threshold (p1226)
has expired.

— Switching on inhibited is activated.
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Preparation for commissioning

Control and status messages

Table 1- 14  Power-on/power-off control

1.6 Powering-up/powering-down the drive system

Signal name Internal control word Binector input PROFdrive/Siemens
telegram 1 ... 352
0 = OFF1 STWA.00 p0840 ON/OFF1 STW1.0
STWAE.00
0 =OFF2 STWA.01 p0844 1. OFF2 STW1.1
STWAE.O1 p0845 2. OFF2
0=OFF3 STWA.02 p0848 1. OFF3 STW1.2
p0849 2. OFF3
Enable operation STWA.03 p0852 Enable operation STW1.3
STWAE.03
Table 1- 15 Switch-in/switch-out status signal
Signal name Internal status word Parameter PROFdrive/Siemens
telegram 1 ... 352
Ready for switching on ZSWA.00 r0899.0 ZSW1.0
ZSWAE.00
Ready for operation ZSWA.01 r0899.1 ZSW1.1
ZSWAE.01
Operation enabled ZSWA.02 r0899.2 ZSW1.2
ZSWAE.02
Pulse inhibit ZSWA.06 r0899.6 ZSW1.6
ZSWAE.06
Pulses enabled ZSWA.11 r0899.11 ZSW2.10

1) only available in Interface Mode p2038 = 0

Function diagrams (see SINAMICS S120/S150 List Manual)

Commissioning Manual

2610 Sequence control - sequencer

2634 Missing enable signals, line contactor control
8732 Basic Infeed - sequencer
8832 Smart Infeed - sequencer

8932 Active Infeed - sequencer
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Preparation for commissioning

1.6 Powering-up/powering-down the drive system
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21 Procedure when commissioning

Once the basic requirements have been met, commissioning can proceed in the following

steps:

Table 2- 1

Commissioning

Step

Activity

1

Create project with STARTER.

Configure the drive unit in STARTER.

Save the project in STARTER.

Go online with the target device in STARTER.

Load the project to the target device.

Dl wN

The motor starts to run.

Note

If motors with a DRIVE-CLIQ interface are used, when the Sensor Module is replaced at the
motor, all motor and encoder data should be saved in a non-volatile manner by setting
parameter p4692 = 1.
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2.1 Procedure when commissioning

2.1.1 Safety guidelines

/\DANGER

A hazardous voltage will be present in all components for a further five minutes after the
system has been shutdown.

Note the information on the component!

/\CAUTION

A project with Safety Integrated can be generated offline; an acceptance test must be
carried out when commissioning, which is only possible online.

Note

The design guidelines and safety information in the Equipment Manuals must be carefully
observed (refer to the documentation SINAMICS S120, Equipment Manual GH1).

CAUTION

In STARTER, after the changeover of the axis type via p9302/p9502 and subsequent
POWER ON, the units that depend on the axis type are only updated after a project upload.

Commissioning Manual
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2.2 STARTER commissioning tool

Short description

The STARTER commissioning tool is used to commission drive units from the SINAMICS
product family.

STARTER can be used for the following:
e Commissioning

® Testing (via the control panel)

® Drive optimization

® Diagnostics

System prerequisites

You can find the system requirements for STARTER in the "readme" file in the STARTER
installation directory.

2.2.1 Important STARTER functions

Description
STARTER provides, among others, the following tools for handling projects:
® Restoring the factory settings
® Commissioning Wizard
® Configuring and parameterizing a drive
® (Creating and copying data sets
® | oading the project from the PG/PC into the target device
® Copy RAM to ROM
® | oading the project from the target device into the PG/PC

Restoring the factory settings

You can use this function to set all the parameters in the working memory of the Control Unit
to the factory settings. To ensure that the data on the memory card is also reset to the
factory settings, choose the "Copy from RAM to ROM" function.

This function can be activated as follows:
® Right-click Drive unit -> Target system -> Restore factory settings
® Drive unit grayed out -> "Restore factory settings" button

For more information about STARTER, see Getting Started for SINAMICS S120.
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2.2 STARTER commissioning fool

Creating and copying data sets (offline)

Drive and command data sets (DDS and CDS) can be added in the drive's configuration
screen. For this, the appropriate buttons must be pressed. Before data sets are copied, all
the wiring needed for both data sets should be completed.

For more information about data sets, refer to the Basics chapter in the SINAMICS S120
Function Manual Drive Functions.

Download to target device

You can use this function to load the current STARTER project to the Control Unit. A
consistency check is first made for the project; if inconsistencies are detected, then the
associated messages are output. You must resolve these inconsistencies before loading. If
no inconsistencies are detected, then the data is loaded into the work memory of the Control
Unit and then a reset is initiated.

This function can be activated as follows:

® Right-click Drive unit -> Target system -> Load to target system

e Drive unit grayed out -> "Load to target system" button

e Online/offline comparison screen form -> "Load project to target device" button

® Project to all drive units simultaneously:
"Load project to target system" button or menu Project -> Load to target system

Copy RAM to ROM

Load to PG/PC

54

You can use this function to save volatile Control Unit data to the non-volatile memory
(memory card). This ensures that the data is still available after the 24 V Control Unit supply
has been switched off.

This function can be activated as follows:
e Extras -> Setting -> Download -> Activate "Copy from RAM to ROM"

This means that every time data is loaded to the target system by choosing "Load project
to target system", the data is stored in the non-volatile memory.

® Right-click Drive unit -> Target system -> Copy from RAM to ROM
® Drive unit grayed out -> "Copy from RAM to ROM" button

You can use this function to load the current Control Unit project to STARTER.
This function can be activated as follows:

® Right-click Drive unit -> Target system -> Load to PG/PC

® Drive unit grayed out -> "Load to PG" button

® "ONLINE/OFFLINE comparison" screen -> "Load to PG" button
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Commissioning Manual, (IH1), 01/2011, 6SL3097-4AF00-0BP1



Commissioning
2.2 STARTER commissioning fool

222 Activating online operation: STARTER via PROFIBUS

Description

The following options are available for online operation via PROFIBUS:

® Online operation via PROFIBUS adapter

STARTER via PROFIBUS (example with 2 CU320-2 DP)

PG/PC

STARTER

O -

PROFIBUS
adapter

PROFIBUS

PROFIBUS interface

DP address
SR
O a
U

Ve %

Address
9

Address
8

Figure 2-1 Connecting the programming device to the target device via PROFIBUS
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2.2 STARTER commissioning fool

Settings in STARTER for direct online connection via PROFIBUS
The following settings are required in STARTER for communication via PROFIBUS:

® Tools -> Set PG/PC Interface...

Add/remove interfaces

e Extras -> Set PG/PC interface... -> Properties

Activate/deactivate "PG/PC is the only master on the bus".

Note
e Baud rate

— Connecting STARTER to an operational PROFIBUS:

STARTER automatically detects the baud rate used by SINAMICS for PROFIBUS.

— Connecting STARTER for commissioning:
The Control Unit automatically detects the baud rate set in STARTER.

¢ PROFIBUS addresses

The PROFIBUS addresses for the individual drive units must be specified in the
project and must match the address settings on the devices.

223 Activating online operation: STARTER via Ethernet

Description

The Control Unit can be commissioned using a programming device (PG/PC) via the
integrated Ethernet Interface. This interface is provided for commissioning purposes only
and cannot be used to control the drive in operation. Routing in conjunction with a CBE20

expansion card is not possible.

Preconditions

e STARTER from version 4.1.5 or higher

STARTER via Ethernet (example)

STARTER PG/PC

OZD. —>

Ethernet
adapter

Ethernet

AV

Control
Unit

Device1
(IP 1)

Figure 2-2  Connecting the programming device to the target device via Ethernet (example)
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Procedure for establishing online operation via Ethernet
1. Installing the Ethernet interface in the PG/PC according to the manufacturer's
specifications
2. Setting the IP address in Windows XP.

The PG/PC is assigned a free IP address here (e.g. 169.254.11.1). The factory setting of
the internal Ethernet interface X127 of the Control Unit is 169.254.11.22.

3. Setting the online interface in STARTER.
4. Assigning the IP address and the name via the STARTER tool.

Setting the IP address in Windows XP

On your desktop, right-click "Network environment" -> Properties -> double-click on the
network card and choose -> Properties -> Internet Protocol (TCP/IP) -> Properties -> Enter

the IP addresses and the subnet mask.

Internet Protocol (TCP/IP) Properties

eneral
You can get IP gettings azsigned automatically if your netwaork, suppaorts

thiz capability. Othemwize, vou need to ask your network, administrator for
the appropriate |P settings.

() Obtain an IF address automatically
(%) Usze the follawing IP address:
IP address: 169 284 11 0 1

Subnet mazk: 2eR 02850 0 .0

Default gateway:

(%) Usze the follawing DMNS server addresses
Prefenred DMS server

Alternate DMS server:

[ Ok H Canicel ]

Figure 2-3  Setting the IP address from the PG/PC
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Settings in STARTER

In STARTER, communication via Ethernet should be set as follows (the Ethernet interface

58

that we use in this example has the designation Realtek RTL8139):

Tools -> Set PG/PC Interface...

New Project

Uszer projects l

3

M amne

| Starage path

% erster Test
% niever Test

% niever Test 4
% nieer Test 4a
% niewer Test 4b

C:\Program FileshSiemenshSteprhe
o hprogram fileshsiemensstep e
C:AProgram Filez\Siemenz\Stephs
C:\Program Filez\Siemenz\Step s
C:%Program Filez\Siemenz\Stephs

% neuer Tests C:%Program Filez\Siemenz\Step s
Eﬂ emavmre T omm b T Drmmr = Cilmnh Cimrm e LN ) S L W
£ »
-
Marme:
|new project | J
-
Storage location [path]:
|I::"~F'ru:ugram FilezhSiemenshStep s Fproj Browse... |
Cancel Help |

Figure 2-4

Selecting the Ethernet interface at the programming device

Right-click on the the drive unit -> Target device -> Online access -> Module address
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Properties - Drives (online) El

General MnduleAddresses]

Rack: 0 _|::|
Slat: 2 _|::|
T arget station: * Local

" Accessible via network transition

Connection ta target station
Type Address

- | 169.254,11.22

Cancel Help

Figure 2-5  Setting online access

Assigning the IP address and the name

Note

ST (Structured Text) conventions must be satisfied for the name assignment of 1O devices in
Ethernet (SINAMICS components). The names must be unique within Ethernet.
The characters "-" and "." are not permitted in the name of an |O device.

Note

The IP address and device name for the Control Unit are stored on the memory card (non-
volatile).

Assignment with STARTER, "Accessible nodes" function
Use the STARTER to assign an IP address and a name to the Ethernet interface.

® Connect the programming device (PG/PC) and the Control Unit using a crosslink
Ethernet cable.

e Switch on the Control Unit.
® Open STARTER.
® FEither create a new project or open an existing one.

® A search is performed for available nodes in Ethernet via Project -> Accessible nodes or
the "Accessible nodes" button.

® The SINAMICS drive object is detected and displayed as a bus node with IP address
169.254.11.22 and without name.
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2.2 STARTER commissioning fool

224

Description

Preconditions

60

Mark the bus node entry and select the displayed menu item "Edit Ethernet node" with
the right mouse button.

In the following "Edit Ethernet node" screen, enter the device name for the Ethernet
interface and click the "Assign name" button. For the IP configuration, enter the subnet
mask (255.255.0.0). Then click the "Assign IP configuration" button and close the mask.

The "Update (F5)" button displays the IP address and name in the entry for the bus node.
If not, close the "Accessible nodes" screen and perform another search for accessible
nodes.

If the Ethernet interface is displayed as bus node, mark the entry and click the "Accept"
button.

The SINAMICS drive is displayed as drive object in the project tree.
Further configurations can be performed for the drive object.

Click "Connect to target system" and load the project to the Control Unit's memory card
with Target system -> Load -> To target device.

Note

The IP address and device name are stored on the memory card of the Control Unitin a
non-volatile fashion.

Parameterizing the interface using the expert list

Assign the "Name of Station" using parameter p8900

Assign the "IP Address of Station" using parameter p8901 (factory setting 169.254.11.22)
Assign the "Default Gateway of Station" using parameter p8902 (factory setting 0.0.0.0)
Assign the "Subnet Mask of Station" using parameter p8903 (factory setting 255.255.0.0)
Activate the configuration with p8905 = 1

Activate the configuration and save with p8905 = 2

Activating online operation: STARTER via PROFINET IO

Online operation with PROFINET IO is implemented using TCP/IP.

STARTER commissioning tool from version 4.1.5 or higher
Communication Board CBE 20 in the Control Unit
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STARTER via PROFINET IO (example)

Ethernet
interface
STARTER PG/ PC \ Control
Ethernet | Ethernet Unit
adapter Device1
(IP 1)

Figure 2-6  STARTER via PROFINET (example)

Procedure for activating online mode with PROFINET
1. Setting the IP address in Windows XP
The programming device (PG/PC) is assigned a fixed, free IP address.
2. Settings in the STARTER commissioning tool

3. Select online operation in the STARTER commissioning tool.

Setting the IP address in Windows XP

On the desktop, right-click on "Network environment" -> Properties -> double-click on
Network card and choose -> Properties -> Internet Protocol (TCP/IP) -> Properties -> Enter
the freely-selectable addresses.

Internet Protocol (TCP/IP) Properties @g|

General

You can get IP settings assigned automatically if pour network, supports
this capability. Otherwise, you need to ask your network. administrator for
the appropriate [P zettings.

() Obtain an IP address automatically
() Use the following IP address:

IP address: 163,254 .11 01
Subnet mask: 2852850 .0

Drefault gateway:

() Use the fallowing DNS server addresses:
Prefered DNS server:

Alternate DNS server:

[ ]9 H Cancel ]

Figure 2-7 Internet Protocol (TCP/IP) properties
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Settings in STARTER
The following settings are required in STARTER for communication via PROFINET:

62

® Tools -> Set PG/PC Interface...

New Project

Uszer projects l
M amne | Starage path A
% erster Test C:\Program FileshSiemenshSteprhe
% neuer Test o hprogram fileshsiemensstep e
% newer Test 4 C:AProgram Filez\Siemenz\Stephs
% never Test 4a C:\Program Filez\Siemenz\Step s
% never Test 4b C:%Program Filez\Siemenz\Stephs
% neuer Tests C:%Program Filez\Siemenz\Step s
Eﬂ emavmre T omm b T Drmmr = Cilmnh Cimrm e LN ) S L W
£ »
-
Marme:
|new project | J
-
Storage location [path]:
|I::"~F'ru:ugram FilezhSiemenshStep s Fproj Browse... |
Cancel Help |

Figure 2-8  Setting the PG/PC Interface
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® Right-click Drive unit -> Target device -> Online access -> Module address

Properties - Drives (online) §|

General  Module Addreszes ]

Rack: i} Q
Slot: 2 A
Target station: + Local

" Accessible via netwark, transitian

Connection ta target station
Type Address

+ | 169.254.11.22

Cancel Help

Figure 2-9  Setting online access
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2.2 STARTER commissioning fool

Assigning the IP address and the name

64

Note

ST (Structured Text) conventions must be satisfied for the name assignment of 10 devices in
PROFINET (SINAMICS components). The names must be unique within PROFINET.
The characters "-" and "." are not permitted in the name of an 1O device.

Assignment with STARTER, "Accessible nodes" function

Use the STARTER to assign an IP address and a name to the PROFINET interface (e.g.
CBE20).

Connect the programming device via Ethernet cable to the Control Unit.
Switch on the Control Unit.
Open STARTER.

A search is performed for available nodes in PROFINET via Project -> Accessible nodes
or the "Accessible nodes" button.

The Control Unit as SINAMICS drive object with CBE20 is detected as node with IP
address 0.0.0.0 and is displayed without name.

Mark the bus node entry and select the displayed menu item "Edit Ethernet node" with
the right mouse button.

In the following "Edit Ethernet node" screen, enter the device name for the PROFINET
interface and click the "Assign name" button. Enter the IP address (e.g. 192.168.0.2) in
the IP configuration and specify the subnet screen (e.g. 255.255.255.0). Then click the
"Assign IP configuration" button. Close the screen.

The "Update (F5)" button displays the IP address and name in the entry for the bus node.
If not, close the "Accessible nodes" screen and perform another search for accessible
nodes.

If the PROFINET interface is displayed as bus node, mark the entry and click the
"Accept" button.

The SINAMICS drive with CBE20 is displayed as drive object in the project tree.
Further configurations can be performed for the drive object.

Click "Connect to target system" and load the project to the Control Unit's memory card
with Target system -> Load -> To target device.

Note

The IP address and device name for the Control Unit are stored on the memory card
(non-volatile).
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2.3 Basic Operator Panel 20 (BOP20)

Short description

The Basic Operator Panel 20 (BOP20) is a basic operator panel with six keys and a two-line
display unit with background lighting. The BOP20 can be plugged onto the SINAMICS
Control Unit and operated.

The BOP20 supports the following functions:

® |nput and changing parameters

Display of operating modes, parameters and alarms

Display and acknowledgement of faults

® Powering-up/powering-down while commissioning

Simulation of a motorized potentiometer

2.3.1 Operation with BOP20 (Basic Operator Panel 20)

2311 General information about the BOP20

The BOP20 can be used to switch on and switch off drives during the commissioning phase
as well as display and modify parameters. Faults can be diagnosed as well as
acknowledged.

The BOP20 is snapped onto the Control Unit. To do this, the blanking cover must be
removed (for additional notes on installation, see the Manual).

Overview of displays and keys

Commissioning Manual
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Drive-No.

Figure 2-10  Overview of displays and keys
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Information on the displays

Table2-2  LED
Display Meaning
top left The active drive object of the BOP is displayed here.
2 positions The displays and key operations always refer to this drive object.
RUN Lit if at least one drive in the drive line-up is in the RUN state (in operation).
RUN is also displayed via bit r0899.2 of the drive.
top right The following is displayed in this field:
2 positions e More than 6 digits: Characters that are still present but are invisible (e.g. "r2" —> 2
characters to the right are invisible, "L1" —> 1 character to the left is invisible)
e Faults: Selects/displays other drives with faults
e Designation of BICO inputs (bi, ci)
¢ Designation of BICO outputs (bo, co)
e Source object of a BICO interconnection to a drive object different than the active one.
S Is (bright) if at least one parameter was changed and the value was not transferred into the non-
volatile memory.
P Is lit (bright) if, for a parameter, the value only becomes effective after pressing the P key.
C Is light (bright) if at least one parameter was changed and the calculation for consistent data
management has still not been initiated.
Below, 6 digit Displays, e.g. parameters, indices, faults and alarms.
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Information on the keys

Table 2- 3 Keys

Name Meaning_;

ON Powering up the drives for which the command "ON/OFF 1" should come from the BOP.
Binector output r0019.0 is set using this key.

OFF Powering down the drives for which the commands "ON/OFF1", "OFF2" or "OFF3" should come
from the BOP.

The binector outputs r0019.0, .1 and .2 are simultaneously reset when this key is pressed. After
the key has been released, binector outputs r0019.1 and .2 are again set to a "1" signal.

Note:
The effectiveness of these keys can be defined by appropriately parameterizing the BICO (e.g.
using these keys it is possible to simultaneously control all of the existing drives).

OO

Functions | The significance of these keys depends on the actual display.

Note:

The effectiveness of this key to acknowledge faults can be defined using the appropriate BiCo
parameterization.

Parameter | The significance of these keys depends on the actual display.

If this key is pressed for 3 s, the "Copy RAM to ROM" function is executed. The "S" displayed on
the BOP disappears.

Raise The keys depend on the current display and are used to either raise or lower values.

Lower

<) & =
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BOP20 functions

Table 2- 4 Functions

Name

Description

Backlighting

The backlighting can be set using p0007 in such a way that it switches itself off automatically
after the set time if no actions are carried out.

Changeover active drive

From the BOP perspective the active drive is defined using p0008 or using the keys "FN" and
"Arrow up".

Units

The units are not displayed on the BOP.

Access level

The access level for the BOP is defined using p0003.
The higher the access level, the more parameters can be selected using the BOP.

Parameter filter

Using the parameter filter in p0004, the available parameters can be filtered corresponding to
their particular function.

Selecting the operating
display

Actual values and setpoints are displayed on the operating display.
The operating display can be set using p0006.

User parameter list

Using the user parameter list in p0013, parameters can be selected for access.

Unplug while voltage is
present

The BOP can be withdrawn and inserted under voltage.
e The ON and OFF keys have a function.

When withdrawing, the drives are stopped.

Once the BOP has been inserted, the drives must be switched on again.

e ON and OFF keys have no function

Withdrawing and inserting has no effect on the drives.

Actuating keys

The following applies to the "P" and "FN" keys:

e When used in a combination with another key, "P" or "FN" must be pressed first and then
the other key.
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Overview of important parameters (see SINAMICS S120/S150 List Manual)

All drive objects

e p0005 BOP operating display selection
e p0006 BOP operating display mode

e p0013 BOP user-defined list

® p0971 Drive object, save parameters

Drive object, Control Unit

® 0002 Control Unit status display

e p0003 BOP access level

e p0004 BOP display filter

e p0007 BOP background lighting

e p0008 BOP drive object selection

® p0009 Device commissioning, parameter filter
e p0011 BOP password input (p0013)

® p0012 BOP password confirmation (p0013)

e 0019 CO/BO: Control word, BOP

® p0977 Save all parameters

Other drive objects (e.g. SERVO, VECTOR, X_INF, TM41 etc.)

e p0010 Commissioning parameter filter
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23.1.2 Displays and using the BOP20

Features
e Operating display
e Changing the active drive object
e Displaying/changing parameters
e Displaying/acknowledging faults and alarms
e Controlling the drive using the BOP20

Operating display

The operating display for each drive object can be set using p0005 and p0006. Using the
operating display, you can change into the parameter display or to another drive object. The
following functions are possible:

® Changing the active drive object
— Press key "FN" and "Arrow up" -> the drive object number at the top left flashes
— Select the required drive object using the arrow keys
— Acknowledge using the "P" key

® Parameter display

Press the "P" key.

The required parameters can be selected using the arrow keys.

Press the "FN" key -> parameter r0000 is displayed

Press the "P" key -> changes back to the operating display
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Parameter display

Commissioning Manual

Commissioning Manual,

The parameters are selected in the BOP20 using the number. The parameter display is
reached from the operating display by pressing the "P" key. Parameters can be searched for
using the arrow keys. The parameter value is displayed by pressing the "P" key again. You
can toggle between the drive objects by simultaneously pressing the keys "FN" and the
arrow keys. You can toggle between r0000 and the parameter that was last displayed by
pressing the "FN" key in the parameter display.

0 @I a
“““ ® 00000

_____ «— |l

BIE

o

Status indicator

Value display
I

Parameter display 1 C1o o
I_I— @ I_IZ _I_
—>

P: Adjustable parameters

@,

in: indexed IR e
I |

r: Display |
parameters

v
|
|

A

Binector parameters | _
bi: binector input Il _1_l
bo: binector output
ci: connector input
co: connector output |

v

A
I

1) You can switch between r0000 and the parameter that was last displayed by pressing the
Fn key in the parameter display.

Figure 2-11  Parameter display
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Value display

72

To switch from the parameter display to the value display, press the "P" key. In the value
display, the values of the adjustable parameters can be increased and decreased using the

arrow. The cursor can be selected using the "FN" key.

Decimal number
e.g. p1521

Integer number
e.g. p0210

Decimal number
e.g.r1084

Time
e.g. r0969
19h:32m:12s:123ms

H: Hexadecimal
number
0x0AO0FB001

Figure 2-12  Value display

Change an individual digit

+ @ Display original value
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Example: Changing a parameter

Precondition: The appropriate access level is set
(for this particular example, p0003 = 3).

Parameter display I I|_| @ I h_l

—» | - | — - -

)

= 3 1M
Value display _I_ @] _I_
—

1)

i

S -] N )

Figure 2-13 Example: Changing p0013[4] from 0 to 300
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Example: Changing binector and connector input parameters

For the binector input p0840[0] (OFF 1) of drive object 2 binector output r0019.0 of the
Control Unit (drive object 1) is interconnected.

= = (P) iC = (P) = iR @]

—|_ __ | = e = =

__|
NN

< =

v | ? !
g
2
5

e e

—

VT 7

(-
==
__
==
—__
—=
I—__
—
—=
|

Figure 2-14 Example: Changing indexed binector parameters
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2.31.3

Displaying faults

Fault and alarm displays

F: Fault
Fault from the
drive object

More than one fault
from the drive object

A fault from a drive object other
than the active one

More than one fault from the
active drive object and from
another

drive object

Figure 2-15 Faults

Displaying alarms

Commissioning Manual

A: Alarm

pressed

Alarms are

»
»

New alarms or alarms are
present and no button has been

for approx. 20 seconds

automatically cycled through

N

Next
fault

(4]
V]

2.3 Basic Operator Panel 20 (BOP20)

Acknowledge
all faults

[ Drive No. flashes

Change @

and fro

—————— drive
1
I

| after 3 seconds

Figure 2-16  Alarms
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2314 Controlling the drive using the BOP20

Description

When commissioning the drive, it can be controlled via the BOP20. A control word is
available on the Control Unit drive object (r0019) for this purpose, which can be
interconnected with the appropriate binector inputs of e.g. the drive.

The interconnections do not function if a standard PROFIdrive telegram was selected as its
interconnection cannot be disconnected.

Table 2-5 BOP20 control word

Bit (r0019) Name Example, interconnection parameters
0 ON / OFF (OFF1) p0840

1 No coast down/coast down (OFF2) p0844

2 No fast stop/fast stop (OFF3) p0848

Note:

For simple commissioning, only bit O should be interconnected. When interconnecting bits 0 ... 2,
then the system is powered-down according to the following priority: OFF2, OFF3, OFF1.

7 Acknowledge fault (0 -> 1) p2102
13 Motorized potentiometer, raise p1035
14 Motorized potentiometer, lower p1036
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2.3 Basic Operator Panel 20 (BOP20)

2.3.2 Important functions via BOP20

Description

Using the BOP20, the following functions can be executed via parameters that support you
when handling projects:

Restoring the factory settings
Copy RAM to ROM
Identification via LED

Acknowledging faults

Restoring the factory settings

The factory setting of the complete device can be established in the drive object CU.

Copy RAM to ROM

p0009 = 30
p0976 = 1

You can initiate the saving of all parameters to the non-volatile memory (memory card) in the
drive object CU:

Press the P key for 3 seconds,

or

p0009 = 0
p0977 = 1
NOTICE

This parameter is not accepted if an identification run (e.g. motor data identification) has

been selected on a drive.

Identification via LED

The main component of a drive object (e.g. Motor Module) can be identified using the index
of p0124. The "Ready" LED on the component starts to flash. The index matches the index
in p0107. The drive object type can be identified via this parameter.

On the drive objects, the components can also be identified via the following parameters:

p0124 Power unit detection via LED
p0144 Voltage Sensing Module detection via LED
p0144 Sensor Module detection via LED

Acknowledging faults

To acknowledge all the faults that have been rectified, press the Fn key.
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24 Creating a project in STARTER
241 Creating a project offline
To create a project offline, you need the PROFIBUS address, the device type, e.g.
SINAMICS S120, and the device version, e.g. firmware version 4.3 or higher.
Table 2- 6 Example of a sequence for creating a project in STARTER

What to do?

How to do it?

Comment

Create a new project

e Operator action:

— Menu "Project"--> New ...
e User projects:

— Projects already in the target directory
e Name: Project_1 (can be freely selected)
Type: Project

Storage location (path): Default (can be set as
required)

New Project x|

User projects |

MHame | Storage path |

Name: Tivpe;
IpmiECUl IPrDiect - I
[~ E Librany

Storage location

IE:'\S iemenzhStep?S 7 proj Browse... |

Cancel | Help |

The project is created offline and
loaded to the target system when
configuration is complete.
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What to do? How to doit? Comment
2. | Add individual drive Operator action: Information about the bus
--> Double-click "Add individual drive unit". address:
Device type: SINAMICS S120 (can be selected) The PROFIBUS address of the

. o . Control Unit must be set for initial
Device version: 4.3 or higher (can be selected) commissioning.
Address type: PROFIBUS/USS/PPI (can be selected) Using the rotary coding switches

Bus address: 37 (can be selected) on the Control Unit, the address
can be set to a value between 1
and 126 and read via p0918. If
the coding switches are at "0"
(factory setting), the value can be
alternatively set between 1 and
126 using p0918.

=& project_1
8 Nzert single drive Linit

Insert single drive unit

General Drive Unit / Buz Address l

Device family: |S|NAMIES

L] L]

Device: | SINAMICS 5120

Device characteristic:

Characteristic Order no.

CUmoDF B5L3 040-0LAD0-Ode
CUFOPN B5L3 040-0LA01 Qe
CU310-2DF B5L3 040-1LADD-Qdese
CU0-2PN B5L3 040-1LAD7T-Odws

“erzion: | 4.4 j
Orline access: |PROFIBUS =
Address: |D j
Slat: =l

Cancel | Help |

3. | Configure the drive unit. | Once you have created the project, you have to configure the drive unit. The following
sections provide some examples.
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242 Searching for a drive unit online
The drive unit must be connected with the programming device (PG/PC) via PROFIBUS or
PROFINET for the online search via PROFIBUS or PROFINET.
Table 2-7  Sequence for searching for a drive unit in STARTER (example)
What to do? How to do it?
1. Create a new Operator action:

project

Menu "Project"--> New with Wizard
Click "Find drive unit online".

Project Wizard Starter il

Introduction

1.
Create
new project

2 i 4,
PGAPC - Set Inzert diive Summary
interface uriits

Aurange drive unitz
offline...

Find drive urits
online...

Open existing
project [offling]...

¥ Display Wizard during start

Cancel |

1.1 Enter the project Project name: Project_1 (can be freely selected)
data. Author: Any
Comment: Any
Project Wizard Starter il
1. 2 3 4.
Introduction Create PG/PC - Set Inzert drive Sumrmary
new project interface urnits
Pleaze enter the project data:
Praject name: IF'roieu:t_‘I|
Author; I
Storage loc.: |C:\Siemens'\8 tep S 7 proj J
Cammeant: ;I
=
< Back | Continue > | Cancel |
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2.4 Creating a project in STARTER

What to do? How to do it?
2. Set up the PG/PC | Here, you can set up the PG/PC interface by clicking "Change and test".
interface
Project Wizard Starter il
1. 2 3 4.
Introduction Create PGAPC - Set Inzert diive Summary
new project interface units
Specify the online connection to the drive unit:
@ Set

interface: I CPEET1PROFIELS)
| Change and test... i
< Back | Continue > | Cancel |

3. Insert drives

Here, you can search for nodes that have been accessed.

Project Wizard Starter
1. 2 i 4.
Introduction Create FG/PC - Set Inzert diive Summary
new project interface units
r— Prewie
E--@ Project_1
ﬂg SIMAMICS_5120_CU320
Refresh
wiEw

< Back | Continue > |

Cancel |

X|
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What to do? How to doit?
4. Summary You have now created the project.

-> Click "Complete".

Project Wizard Starter il

1. 2. 3 4
Introduction Create PGAPC - Set Ihsert drive Summary
new project interface units
The following zettings have been selected: ;I

- Project name: Project_1
Storage location: C:A\SiemenstStep S Tpro|

- Interface: CPEE11(PROFIEUS]
- Drive urits:

SIMAMICS_S5120_CU320 [SINAMICS 5120 CU320, A

-
1 | E

5. Configure the drive | Once you have created the project, you have to configure the drive unit. The following
unit. sections provide some examples.
2.5 First commissioning, servo control mode, booksize format

The example provided in this section explains all the configuration and parameter settings,
as well as the tests that are required for initial commissioning. Commissioning is carried out
using the STARTER commissioning tool.

Requirements for commissioning
1. The commissioning requirements have been met according to Section 1.1.

2. The check list - Table 1-1 or 1-2 from the Chapter Preparing for commissioning - has
been filled out and the points complied with.

3. The STARTER commissioning tool is installed and activated.
--> see the "Readme" file on the STARTER installation CD.
4. The power supply (24 V DC) is switched on.
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251 Task

1. Commission a drive system with the following components:

Commissioning Manual

Table 2- 8

2.5 First commissioning, servo control mode, booksize format

Component overview

Desig_]nation

Component

Order number

Closed-loop control and infeed

Control Unit 1

Control Unit 320-2DP

6SL.3040-1MA00-0AAQ

Active Line Module 1

Active Line Module 16 kW

6SL3130-7TE21-6AAX

Line filter package 16 kW

Line filter and line reactor

6SL3000-0FE21-6AAX

Drive 1

Motor Module 1

Single Motor Module 9 A

6SL3120-1TE21-0AAX

Sensor Module 1.1

SMC20

6SL3055-0AA00-5BAX

Motor 1

Synchronous motor

1FK7061-7 AF 7X—XXXX

Motor encoder 1

Incremental encoder sin/cos C/D
1 Vpp 2048 p/r

1FK7 XXX=XXXXX—XAXX

Sensor Module 1.2

SMC20

6SL3055-0AA00-5BAX

External encoder

Incremental encoder
sin/cos 1 Vpp 4096 p/r

Drive 2
Motor Module 2 Single Motor Module 18 A 6SL3120-1TE21-8AAX
Motor 2 Induction motor 1PH7103-xNGxx—xLxx

Sensor Module 2

SMC20

6SL3055-0AA00-5BAX

Motor encoder 2

Incremental encoder sin/cos
1 Vpp 2048 p/r

1PH7XxX=XMXXX—XXXX

1. The enable signals for the infeed and the two drives must be transmitted via PROFIBUS.

Telegram for the Active Line Module

Telegram 370: Infeed, 1 word

Telegram for drive 1
Standard telegram 4: Speed control, 2 position encoders

Enable signals for drive 2
Standard telegram 3: Speed control, 1 position encoder

Note

For more information about telegram types, see Function Manual SINAMICS S120 or

SINAMICS S120/S150 List Manual.
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2.5.2

84

Component wiring (example)

The following diagram shows a possible component configuration and wiring option. The
DRIVE-CLIiQ wiring is highlighted in bold.

L1
L2
T L3
~
24V DC
external
2 2
DRIVE-CLIQ
| I |
] | | I | | |
TIH T T IOy T T ooy T KITh
X100 X200 _ 34 (X200 X200
EP
Control =
Unit
1 F|_, | |
HX124 Active Single Single X500 1X500 |X500
Li Mot Mot SMC20 [ SMC20|SMC20
Do ine Sigelr Gy 1.0 1.1 2.0
Module Module 1 Module 2
x5200] x520§| x5200:]
. .
&) DiD D
L L1t L1
Line contactor : : :
. .
A
] ] h
H H '
@ @ @ P
L L L : : H
: = = = ' H '
Line reactor Motor cable Encoderi E H
cable : H
peccccccccccbeccccccccccccccaa 'l ' N
' R H H
P s
i :
H [
: H

Figure 2-17 Component wiring (example)

|

For more information on wiring and connecting the encoder system, see the Equipment

Manual.
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253 Signal flow of the commissioning example
L1
? L2
[ m ~ . I3
| ACTIVE INFEED CONTROL ! [2130] | Line connection
i | asoutput DI/DO 8
, (8934] ; PO728.8=1 X122.7 U
! [r0863.1) | Op0738 = r0863.+—0O—
| i .
i Clowrmen | oo -
. : X122.8
| Receive process data ' 75591d 1 ~
. = ) (—|_Ci
| STWA p086Q r0723.9( | P O
©[2447] Main contactor T 1
! feedback signal . [ Active Line Module !
| Send process data | C
i ZSWi1 | > _"/\r :
- [2459] | ! !
I Infeed ready . | |
| [8932] [r0863.0 I L o
LY __._. l |1
DCP/DCN
Figure 2-18 Signal flow of the commissioning example - servo - Part 1
Infeed ready
[8932]  [r0863.0 ) )p0864 = 0863.0|%610]
SERVO CONTROL 1 DCP/DCN
Receive process data Send process data J J
1| sTw1 1 zswi | a4t [ -
[2440] I Motor Module 1 |
12 INsoLL B 12 | nisT B p2060(1] j
3 | 3 - NSOLL B p1os5 P1140 o142 : |
4 | sTw2 4 | zsw2 I ! i
5 [G1sTW 5 [G1 ZsW 1_\_ : I : i
6 |G2_STW 6 N !
- — » |
[2440] 7 oS 0° :\’__ g ‘"i r@
8 0 | .
TGLXISTz Setpoint channel [3080] Speed | |
10 [G2.ZswW controller | |
11 . e |
—{G2_xIST1
12
113 lso xisT2
14
[2450]
Infeed ready
[8932]  [r0863.0 ) Hp0864 = oaea.ollfol
SERVO CONTROL 2
Receive process data Send process data
1] sTwi 1 [ Zswi [2440] '™ Motor Module 2|
2 2 p20e0n] p1140 i !
1 2 | 1 2 | NSOLL_B j
S NsoLL B 5 NisT-B = p1055 T pl142 ! :
4 | sTw2 4 | zsw2 % gJ I | i
5 [G1_XIST2 5 [G1_ZSW TN | ;
TN > |
[2440] %GLXISH o° _;_\__ 'i —"i r@
0 J
8 Setpoint channel [3080] Speed | I
g |°1-XIST2 controller : |
[2450] . |

Figure 2-19  Signal flow of the commissioning example - servo - Part 2
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254 Commissioning with STARTER (example)
The table below describes the steps for commissioning with STARTER.
Table 2-9  Sequence for commissioning with STARTER (example)
What to do? How to do it? Comment
1. | Automatic Operator action: -
configuration -> "Project” -> "Connect to target system"
-> Double-click "Automatic configuration”.
-> Follow the instructions provided in the wizard.
Note:

When the factory setting is p7826 = 1, the firmware is automatically updated to the status on the memory card when a
configured DRIVE-CLiIQ component is first booted. This may take several minutes and is indicated by the READY-LED on
the corresponding components flashing green/red and the Control Unit flashing orange (0.5 Hz). Once all updates have
been completed, the READY-LED on the Control Unit flashes orange at 2 Hz and the corresponding READY-LED on the
components flashes green/red at 2 Hz. For the firmware to be activated, a POWER ON must be carried out for the
components.

2.

Configure the infeed

The infeed must be configured.

Name of infeed -> Double-click "Configuration" -> Click
"Wizard"

2.1

Infeed wizard

The wizard displays the data determined automatically from
the electronic rating plate.

You can now set the line/DC link identification.

The device supply voltage must be entered; the rated line
frequency is automatically determined by the firmware.

"Line filter available" must be active.

With a booksize infeed, one of up to three line filter types can
be selected in the offered menu when this option is activated.

With a chassis infeed, only one AIM line filter suitable for the
infeed is automatically added with the above option.

PROFIBUS telegram type 370 must be installed.
Then the configuration for the infeed is completed.

If the line environment or DC
link components are
changed, line/DC link
identification should be
repeated.

Configuring drives

The drives must be configured individually.

-> "Drives" -> Drive name -> Double-click "Configuration" ->
Click "Configure DDS"

3.1

Control structure

You can activate the function modules.
You can select the control type.

3.2

Power unit

The wizard displays the data determined automatically from
the electronic rating plate.

Caution
If the infeed is controlled by a different Control Unit, the "Ready" signal for the infeed r0863.0 must be interconnected with
drive parameter p0864 "Infeed ready" via a digital input/output. If this is not taken into account, the infeed may be

damaged.

3.3 | Motor The name of the motor (e.g. equipment marking) can be You can select a standard
entered. motor from the motor list or
Select standard motor from list: Yes you can enter the motor data
Select th tor t " lat manually. You can then

elect the motor type (see rating plate). select the motor type.
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What to do? How to do it? Comment
3.4 | Motor brakes Here, you can configure the brake and activate the "Extended | For more information, see
brake control" function module. the Function Manual.
3.5 | Motor data You can enter the motor data on the rating plate here. If you do not enter any
Induction motors (rotary): mechanical data, it is

estimated on the basis of the

If known, mechanical data for the motor and drive train can be .
data on the rating plate.

entered.
The equivalent circuit

diagram data is also

If known, the data for a PE spindle can be entered. estimated on the basis of the
data on the rating plate or
determined by means of
automatic motor data
identification.

Synchronous motors (rotary, permanent-magnet)

Caution
If the motor is replaced after transferring project data from the programming device to the drive, then before any data is
transferred again, the pulse frequency must be checked.

3.6 | Encoder Motor encoder (encoder 1): If you are using an encoder
Choose standard encoder from list: Yes that is not in the list, you can
Select "2048, 1 Vpp, A/B C/D R" also enter the data
External encoder (encoder 2): manually.
rotary: Yes

Measuring system: "incremental sinusoidal/cosinusoidal”
Resolution: "4096"
Zero mark: "No zero marker"

3.7 | Process data PROFIBUS telegram type 4 (drive 1) and 3 (drive 2) mustbe |-
exchange selected.
3.8 | Drive functions Here, after entering the motor data the technological Your choice of application
application can be selected. influences the calculation for
the open-loop/closed-loop
control parameters.
3.9 | Summary The drive data can be copied to the clipboard for plant -
documentation purposes and then added to a text program,
for example.
Note

The reference parameters and limit values can be protected from being automatically overwritten in the STARTER by
p0340 = 1: Drive -> Configuration-> Reference parameters / blocked list tab.
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What to do? How to do it? Comment
4. Line contactor Line contactor The line contactor must be
p0728.8 = 1 Set DI/DO as output controlled by the infeed_1
. drive object.
p0738 =863.1 Line contactor ON See function di 8934
p0860 = 723.9 Line contactor, feedback signal ee function diagram [ ]
In the function --> Line
contactor control screen,
you can check that the
interconnection is correct.
E|m| Control_Unit |zolated digital inputs ~ Bidirectional digital inputs/outputs | Measuring SDCkEtSI
----- ® Insert DCC charts
ey Configuration
o > Control logi 122 m Invert output Dptimize wigw / simulatil
DI g e s n Ol = [ cam—
7 M——@I—O |Infeed, 63 Bit 1, CO/B0: Drive |:(|
IInput ;I
DI g ot — O = .
B ““"—@I—Olﬂ = E—O Infeed. pag0. B Lj
5. | Save the parameters |e Connect with target system (go online) Position cursor on drive unit
on the device . (SINAMICS S120) and right-
e Target system -> Download to target device click
e Target system -> Copy from RAM to ROM
(save the data on the memory card)
6. | The motor starts to The drives can be started via the control panel in STARTER. | For more information about
run. e Once the pulses for the infeed have been enabled the tg:ﬂ?gntg;f;za’ see
line/DC link identification will be activated and carried out. 9 ' )
The infeed then switches to operational mode. The control panel supplies
the control word 1 (STW1)
and speed setpoint 1
(NSOLL).
For more information about
line/DC link identification,
see the SINAMICS S120
Function Manual.
STARTER diagnosis options
Under "Component" -> Diagnosis -> Control/status words
e Control/status words
e Status parameters
® Missing enable signals
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2.6 First commissioning control mode vector U/f in booksize format

The example provided in this section explains all the configuration and parameter settings,
as well as the tests that are required for initial commissioning. Commissioning is carried out
using the STARTER commissioning tool.

Requirements for commissioning

2.6.1

Commissioning Manual
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1. The commissioning requirements have been met according to Section 1.1.

2. The check list - Table 1-1 or 1-2 from the Chapter Preparing for commissioning - has
been filled out and the points complied with.

3. The STARTER commissioning tool is installed and activated.

--> see the "Readme" file on the STARTER installation CD.

4. The power supply (24 V DC) is switched on.

Task

A drive, booksize format with vector U/f control mode with the following components is to be

commissioned for the first time:

Table 2- 10 Component overview

Desig_]nation

Component

Order number

Closed-loop control and infeed

Control Unit

Control Unit 320-2DP

6SL3040-1MA00-0AAQ

Smart Line Module

Smart Line Module 10 kW

6SL3130-6AE21-0AAX

Line filter package 10 kW

Line filter and line reactor

6SL3130-0GE21-0AAX

Drive 1

Motor Module Single Motor Module 5 A 6SL3120-1TE15-0AAX
Motor Induction motor 1LA

Drive 2

Motor Module Single Motor Module 5 A 6SL3120-1TE15-0AAX
Motor Induction motor 1LA

The enable signals for the infeed and the drive should be realized via terminals.
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2.6.2 Component wiring (example)

The following diagram shows a possible component configuration and wiring option. The
DRIVE-CLIiQ wiring is highlighted in bold.

L1

L2
T L3
f~
24V DC
external
2\ 2
—{I1] I--IJ'I_I_H_I_I'I—InlJ'I_I_H_I_l_I—#
X100 = @0 %;1 X200 X200
Rdy
Control = 24vDC
Unit 600 VDC
Smart Line Single Motor Single Motor
HX124 Module Module 1 Module 2
X22
DI
1424V
2 EZ Disable
L
@ Line contactor
T I T
Line reactor -
Motor
cable
4 4
= =

Figure 2-20 Component wiring (example)

For more information on wiring and connecting the encoder system, see the Equipment

Manual.
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2.6.3

2.6 First commissioning control mode vector U/f in booksize format

Signal flow of the commissioning example

[2610]

107224

[2120]

Dl 4
X1321

1{ [2501]

Vector U/f 1

)p0840 = r0722.0 - 0 = AUS1

)p0844 = r0722.1 |- 0 = AUS2

)p0848 = r0722.2}— 0 = AUS3

p1140

pore [
S~ H—

for each, 1 enable
p1141
p1142

Line connection

IR

m

X211 —ui
)_TReady

Smart Line Module

+ -

Motor Module 1

4

Motor Module 2

L

o . Setpoint
o085z = 07223} OPeration channel  Ramp- Speed
enabled [3030]  function  controller
")p1020 = r0722.7 generator
p1021=0 [3060]
pT022 =0
1023 =0 —
AA4
0.000 ©0000
P1001[D]
Fixed setpoints
[3010]
ector U/f 2

X124.4 M
24V DC X124.3
external
X124.2 +
x1241 \| ,
X122.1 (2100]
—"- - I Dl {r0722.0)
Enable " X122.2 DI 1 {F0722-
signals I
Motor - X122.3 DI 2 57533
Modules X122.4 I 1r0722.29)
—" - D3 {r0722.3)
X132.4 I DI 7
Fixed setpoint — - [07227)
selection
Figure 2-21

Signal flow diagram of the example vector U/f control mode in the booksize format
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264 Commissioning with STARTER (example)

The table below describes the steps for commissioning the example using the STARTER
commissioning tool.

Table 2- 11 Sequence for commissioning with STARTER (example)

What to do? How to do it? Comment
1. Automatic Operator action:
configuration -> "Project" -> "Connect to target system"

-> Double-click "Automatic configuration”

-> Follow the instructions provided in the wizard.

Note:

When the factory setting is p7826 = 1, the firmware is automatically updated to the status on the memory card when a
configured DRIVE-CLiIQ component is first booted. This may take several minutes and is indicated by the READY-LED on
the corresponding components flashing green/red and the Control Unit flashing orange (0.5 Hz). Once all updates have
been completed, the READY-LED on the Control Unit flashes orange at 2 Hz and the corresponding READY-LED on the
components flashes green/red at 2 Hz. For the firmware to be activated, a POWER ON must be carried out for the
components.

2. Configuring drives | The drives must be configured individually.

-> "Drives" -> Drive name -> Double-click "Configuration" ->
Click "Configure DDS"

2.1 Control structure You can activate the function modules.

You can select the control type.

2.2 | Power unit The wizard displays the data determined automatically from the | Caution

electronic rating plate. If a sine-wave filter is
connected, it must be
activated here to prevent it
from being destroyed.

2.3 | BICO power unit Infeed in operation
Control Unit: r0722.4 (digital input 4)

Caution

If the infeed is controlled from another Control Unit, then the ready signal of the infeed must be connected to parameter
p0864 "infeed ready" of the drive through a digital input/output. If this is not taken into account, the infeed may be
damaged.

2.4 | Drive setting You can select the motor standard (IEC/NEMA) and power unit
application (duty cycles).

2.5 | Motor The name of the motor (e.g. equipment marking) can be entered. | You can select a standard
Enter motor data: Yes motor from the list of

motors or you can enter the
motor data yourself
manually. You can then
select the motor type.

Select motor type "1LAX".
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What to do? How to doit? Comment
2.6 Motor data You can enter the motor data from the rating plate here. If you do not enter any
If known, mechanical data for the motor and drive train can be mephanlcal data, it s
entered. estimated on the basis of
Equivalent circuit diagram data: No the data on the rating plate.
The equivalent circuit
diagram data is also
estimated on the basis of
the data on the rating plate
or determined by means of
automatic motor data
identification.
2.7 Motor brake Here, you can configure the brake and activate the "Extended For further information see
brake control" function module. Function Manual.
2.8 | Drive functions You can choose the application and motor data identification Your choice of application
here. influences the calculation
Motor data identification: "1" for the open-loop/closed-
loop control parameters.
When the pulses are
enabled, a one-off
identification run is carried
out. Current flows through
the motor which means that
it can align itself by up to a
quarter of a revolution.
Once the measurement is
complete, optimization with
rotating motor is carried out
the next time the pulses are
enabled.
29 Important You must enter important parameters in accordance with the
parameters relevant application.
Note, for example, the general mechanical conditions for the
drive train.
2.10 | Summary The drive data can be copied to the clipboard for system
documentation purposes and then pasted into a word processing
program, for example.
Note

The reference parameters and limit values in the STARTER can be protected from being automatically overwritten by
p0340 = 1. In the STARTER, you will find this under Drive -> Configuration-> Reference parameters / blocked list tab.

3.

Enable signals and
BICO
interconnections

The enable signals for the infeed and the two drives must be
realized via the digital inputs on the Control Unit.
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What to do? How to do it? Comment
3.1 | Line contactor e Line contactor The line contactor must be
controlled by the
p0728.8 = 1 Set DI/DO as output Einspeisung_1 drive object.
_ . . The inputs/outputs are
0738 = 863.1 Activate line contactor .
P located on the Control Unit.
p0860 = 723.9 Line contactor, feedback signal See the function diagram
[8934]
E|m Control_Unit Izolated digital inputs — Bidirectional digital inputs/outputs | teasuring socketsl
-7 Insert DCC chd
- » Configuration
- Contral logi w122 Irert output Optimize view ¢ simulati
» Control QI m rivert outpul ptinize: wiew / simulation
Dl g e e a O ] 1) om—
! M——EI—O' [Inte=d, 18E3: Bit 1, CO/BO: Drivi L |
IInput ;I
Dl oft— O] = :
a8 * 1 O Infeed, pBE0, BI: Ling
A el =L
3.2 | Enable Motor o Enable signals for the Motor Module (drive_1) See function diagram
Module [2501]
p0840 = 722.0 ON/OFF1
p0844 =722.1 1. OFF2
p0845 =1 2. OFF2
p0848 =722.2 1. OFF3
p0849 =1 2. OFF3
p0852 = 722.3 Enable operation
E-f Drive_1 BI/0 |BO/CO |
""" #1 Insert DCC chy }:|I Control_Unit, 722 Bit 0, CO/BO: CU digital inputs, status: : DI 0 p1221121.1]( () pa40[0], Bl: OM/OFFT
-3 Drive navigatel 1[0 @ pa40[1]. BI: OM/OFFT
""" » Configuration T | Contral_Unit, 722: Bit 1, CO/B0: CU digital inputs, status: : DI 1 [<122.244121.2] O pa44[0]. BI: 1. OFF2
----- » Conirol logic i ] Q PE44[1]. BI: 1. OFF2
E- Open-loop,log | O pB45[0]. Bl: 2. OFF2
&% Functions [ © pB45[1], Bl: 2. OFF2
> Messages and | - e F o 1722 60 2, CO/80, CU dghal ipits, stabus. - D1 2 RIZZ0121 31T () pE43[0]. BI: 1. OFF3
-3 Commissioning Sk © o491, Bl 1. OFF3
E-% Communicatio P :
) ! [ O pa49[0]. EI: 2. OFF3
=% Diagnostics
] O pa49[1]. Bl 2. OFF3
e > Conirolfstat _
: e Tl Control_Unit, (722: Bit 3, CO/B0: CU digital inputs, status: : DI 3 (122.445121.4) O pa52[0]. Bl: Enable operatian
- }:||1 O pE5Z[1]. Bl: Enable operation
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What to do? How to doit? Comment
3.3 | Ramp-function o Ramp-function generator See function diagram
generator [3060]

p1140 = 1 Ramp-function generator enable

p1141 = 1 Ramp-function generator start

p1142 = 1 Enable setpoint

=@ Drive_1 Bi/Cl | BO/CO |
%7 Insert DCC cha E 1 O p1140[0]. Bl: Enables the ramp-fur
-3 Drive navigato | | O p1140[1]. Bl: Enables the ramp-fun
o Conﬁguratign QF O p1141[0]. BI: Start ramp-function og
- 2 control logic Qh O pl141[1], BI: Start ramp-function ge
H- 3% Open-loop/clog _ }
4% Functions j| O pl1142[0]. Bl: Enable speed setpofn
59 Messages and T O p1142[1]. Bl: Enable speed setpoin
-3 Commissioning
E-» Communicatio
=% Diagnostcs
» Control/stal
bR [Nterconned
3.4 | Setpoint e Specify setpoint See function diagram
[3010]
p1001 = 40 Fixed setpoint 1
- Drive_1 Fized setpoints  Fined setpoint interconnection |
B Insert DCC chi
-~ Drive navigato
- > Configuraton Fised value 4 RPh | p1070[0], CI: Main setpaint !|
- » Confrol logic
= » Setpoint Charn
> Motor pote
Y- o)
4 Save the e Connect target system (go online) Position cursor on drive
zargmeters on the e Target device -> Load to target device u_nlt (S!NAMICS $120) and
evice right-click.
e Target device -> Copy from RAM to ROM
5 The motor starts to | The drives can be started via the control panel in STARTER. For more information about
run. the control panel, see

e Line/DC link identification will be carried out once
the pulses for the infeed have been enabled and line/DC link
identification has been activated. The infeed then switches to
operational mode.

Getting Started.

During motor data
identification, a current
flows through the motor,

¢ Once the pulses are enabled, a one-off motor data which means that it can
identification run (if activated) is carried out. align itself by up to a

e When the pulses are enabled again, optimization with a quarter of a revolution.
rotating motor (if activated) is carried out. For more information about

line/DC link/motor data
identification, see the
Function Manual.
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STARTER diagnosis options
Under "Component" -> Diagnosis -> Control/status words
e Control/status words
e Status parameters

® Missing enable signals

2.7 First commissioning, vector control mode in the chassis format

The example provided in this section explains all the configuration and parameter settings,
as well as the tests that are required for initial commissioning. Commissioning is carried out
using the STARTER commissioning tool.

Requirements for commissioning
1. The commissioning requirements have been met according to Section 1.1.

2. The check list - Table 1-1 or 1-2 from the Chapter Preparing for commissioning - has
been filled out and the points complied with.

3. The STARTER commissioning tool is installed and activated.
--> see the "Readme" file on the STARTER installation CD.
4. The power supply (24 V DC) is switched on.
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271 Task

A drive in the chassis format in the vector control mode with the following components is to
be commissioned for the first time:

Table 2- 12 Component overview

Designation Component Order number
Closed-loop control and infeed
Control Unit Control Unit 320-2DP 6SL3040-1MA00-0AAQ
Active Line Module Active Line Module 380 kW /400 V | 6SL3330-7TE36-1AAX
Active Interface Module Active Interface Module 6SL3300-7TE38-4AAX
Drive 1
Motor Module Motor Module 380 A 6SL3320-1TE33-8AAX
Motor Induction motor Type: 1LA8
+ Winou rak e otage - 400
» With encoder rated power = 200 kW

rated power factor = 0.86
rated frequency = 50.00 Hz
rated speed = 989 rpm
cooling type = natural cooling
HTL encoder, 1024 p/r, A/B, R

Drive 2
Motor Module Motor Module 380 A 6SL3320-1TE33-8AAX
Motor Induction motor Type: 1LA8

rated voltage = 400 V

rated current = 345 A

With encoder rated power = 200 kW

rated power factor = 0.86
rated frequency = 50.00 Hz
rated speed = 989 rpm
cooling type = natural cooling
HTL encoder, 1024 p/r, A/B, R

e Without brake

The enable signals for the infeed and the drive should be realized via terminals.
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2.7.2 Component wiring (example)
The following diagram shows a possible component configuration and wiring option. The
DRIVE-CLIiQ wiring is highlighted in bold.
L1 AC DC
L2 230V 24V
T L3 external external
= L[N M
[] [] [] DRIVE-CLIQ
|
‘&}1) I [ !
X1 %(01%1 X500 X400|X402 X400 X402 X400 X402
Control e xaol
Unit 1LF
X520[]|x520 ]
320-2DP | 3[1— X9 X9 X9 Qo
— 1 1 1 H H
:Hx124 j 2 2E‘: ZB: I L E
o 5 : :
10 6 ' H
1" ] ]
@ |* P
1 Active Active Motor Motor E E
- Interface Line Module 1 Module 2 : :
Module Module ' : .
' ' DC connection
|t —i DCP/DCN
— | H H
I I L

L

Figure 2-22 Component wiring (example)

1) X500 at the Voltage Sensing Module

For more information on wiring and connecting the encoder system, see the Equipment
Manual.
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273

24V
external

Enable
signals
Line
Modules

Enable
signals
Motor
Modules

Fixed setpoint
Selection of

2.7 First commissioning, vector control mode in the chassis format

Signal flow of the commissioning example

X124.4

X124.3
X124.2

X124.1

ACTIVE INFEED CONTROL

L1
L2
L3

Line connection

I

Interface Module

Active Line Module

K

Fixed setpoints
[3010]

Motor Module 1

X132.1 [2120] [8920]
— 3. I [f0722.4) | Dposao=rorzz.a}— 0 = AUS1
— X132.2 DS {r0722.5) dp0849 = ro722.61— 0 = AUS3
[8932] Infeed ready [2610]
| foeso
X122.1 [2100] [2501] Veklor Control 1 for each, 1 enable
S : [r0722.0) Yp0840 = r0722.0}— 0 = AUS1 p1141
X122.2 I p1140 | pi142
S I [r0722.1 ) pos4d =r0722.1}— 0 = AUS2 p1070
- X1223 ! {r0722.2) Ypo0848 = r0722.2}- 0 = AUS3 || :
X122.4 I . Setpoint
—"- DI3 {r0722.3) ; | Jp0852=r0722.3}— OPeglatLO” channel  Ramp- Speed
I enable [3030] function controller
L X132.4 Di7 [r0722.7) Y p1020 = r0722.7] generator
PI027=0 [3060]
51022 =0
1023=0
0.000
P1001[D]

4+ o)

Motor Module 2

4z @)

Vektor Control 2

Figure 2-23  Signal flow of the commissioning example chassis
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274 Commissioning with STARTER (example)

The table below describes the steps for commissioning the example with STARTER.

Table 2- 13  Sequence for commissioning with STARTER (example)

What to do? How to do it? Comment
1. Automatic Operator action: The DRIVE-CLIQ topology is
configuration -> "Project"--> "Connect to target system" determined and the electronic

rating plates are read. The data is
then transferred to STARTER.

The next steps are carried out
offline.

-> Double-click "Automatic configuration"
-> Follow the instructions provided in the wizard.

STARTER then automatically switches to offline
mode.

Note:

When the factory setting is p7826 = 1, the firmware is automatically updated to the status on the memory card when a
configured DRIVE-CLiIQ component is first booted. This may take a few minutes and is indicated by the READY-LED on
the corresponding components flashing green/red and the Control Unit flashing orange (0.5 Hz). Once all updates have
been completed, the READY-LED on the Control Unit flashes orange at 2 Hz and the corresponding READY-LED on the
components flashes green/red at 2 Hz. For the firmware to be activated, a POWER ON must be carried out for the
components.

2. Configure the infeed The infeed must be configured.

Name of infeed -> Double-click "Configuration" ->
Click "Wizard"

2.1

Infeed wizard

The wizard displays the data determined
automatically from the electronic rating plate.

You can now set the line/DC link identification.

The device supply voltage must be entered; the
rated line frequency is automatically
determined/specified for this by the firmware.

"Line filter available" must be active.

With a booksize infeed, one of up to three line filter
types can be selected in the offered menu when this
option is activated.

With a chassis infeed, only one AIM line filter
suitable for the infeed is automatically added with the
above option.

PROFIBUS telegram type 370 must be installed.
This completes the configuration for the infeed.

If the network environment or
components in the DC link change,
the line/DC link identification
should be carried out again.

Configuring drives

The drives must be configured individually.

-> "Drives" -> Drive name -> Double-click
"Configuration" -> Click "Configure DDS"

3.1

Control structure

You can activate the function modules.
You can select the control type.
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What to do? How to doit? Comment
3.2 Power unit The wizard displays the data determined Caution
automatically from the electronic rating plate. If a sine-wave filter is connected,
then it must be activated here as
otherwise it could be destroyed!
Caution

If the infeed is controlled by a different Control Unit, the "Ready" signal for the infeed r0863.0 must be interconnected with
drive parameter p0864 "Infeed ready" via a digital input/output. If this is not taken into account, the infeed may be
damaged.

3.3

Drive setting

You can select the motor standard (IEC/NEMA) and
power unit application (duty cycles).

3.4 Motor The name of the motor (e.g. equipment marking) can | You can select a standard motor
be entered. from the list of motors or you can
Enter motor data: Yes enter the motor data yourself. You
Select motor type "1LA8" can then select the motor type.
3.5 Motor data You can enter the motor data on the rating plate If you do not enter any mechanical
here. data, it is estimated on the basis of
If known, mechanical data for the motor and drive the data on the rating plate.
train can be entered. The equivalent circuit diagram data
Equivalent circuit diagram data: No is also estimated on the basis of
the data on the rating plate or
determined by means of automatic
motor data identification.
3.6 Motor brake Here, you can configure the brake and activate the For more information, see the
"Extended brake control" function module. Function Manual.
3.7 Encoder Choose standard encoder from list: Yes If you are using an encoder that is
Choose "1024 HTL A/B R to X521/X531". notin the list, you can also enter
the data.
3.8 Drive functions You can choose the application and motor data Your choice of application
identification here. influences the calculation for the
Motor data identification: "1" open-loop/closed-loop control
parameters.
When the pulses are enabled, a
single motor data identification run
is carried out. Current flows
through the motor which means
that it can align itself by up to a
quarter of a revolution. Once the
measurement is complete,
optimization with rotating motor is
carried out the next time the pulses
are enabled.
3.9 Important parameters | You must enter important parameters in accordance

with the relevant application.

Note, for example, the general mechanical
conditions for the drive train.
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What to do? How to do it? Comment
3.10 | Summary The drive data can be copied to the clipboard for
plant documentation purposes and then added to a
text program, for example.
Note

The reference parameters and limit values in the STARTER can be protected from being automatically overwritten by
p0340 = 1. In the STARTER, you will find this under Drive -> Configuration-> Reference parameters / blocked list tab.

4. Enable signals and The enable signals for the infeed and the two drives | Note:
BICO interconnections must be realized via the digital inputs on the Control | |f an Active Line Module is
Unit. installed, the same signal source
must not be used to enable both
the infeed and the drive.
41 Active Line Module e Enable signals for the Active Line Module See function diagram [8920]
p0840 = 722.4 ON/OFF1
p0844 = 722.5 OFF2
p0852 = 722.6 Enable operation
Infeed Bl/CI | BO/CO |
#7 Insert pec charts ¥ Cu_S_037. 722 Bit 4, CO/BO: CU digital inputs, status: : DI 4 [<132.1) [1=High / | () pB40[0]. BI: ONADFFT
> Configuration T CU_S_057. 1722 Bit 5, C0/BO0: CU digtal inputs, status:: DI 5 [<132.2) (1=High /| {3J p344[0]. BI: 1. OFF2
>>> '(::ontrugl logic S ] O pB45[0]. BI: 2. OFF2
LINCTOoNs
B9 Communication F [ CU_S_037. 722 Bit 6. CO/B0: CU digital inputs, status: : DI 6 (<132.3] [1=High / | {5 pB52(0). Bl: Enable operation
E| ¥ Diagnostics T O pa54{0], BI: Master ctil by PLC
4.2 Enable Motor Module |« Enable signals for the Motor Module (drive_1) See function diagram [2501]
p0840 = 722.0 ON/OFF1
p0844 =722.1 1. OFF2
p0845 =1 2. OFF2
p0848 = 722.2 1. OFF3
p0849 =1 2. OFF3
p0852 = 722.3 Enable operation
p0864 = 863.0 Infeed operation
&l Drive_L B/l |BO/CO |
----- ) Insert DCC charts }:|I Contrel_Urit, r722: Bit 0. CO/BO: CU digitsl inputs, status: @ DI 0 p41221431211) () pa40[0]. BI: OW/OFFT
-8 Drive navigator j [ O pE40[1], Bl: ON/OFF1
""" > Configuration Tl Control_Unit, r722: Bit 1. CO/BO: CU digital inputs, status: : DI 1 [X122.24<121.2] [ O pa44{0]. BI: 1. OFF2
..... > Confrol logic I © pE44[1], BI: 1. OFF2
-3 Open-loop/dosed-| I O pB45[0], BI: 2. OFF2
&% Functions = ) pB45[1], BI: 2. OFF2
> Messages and MON| e 757 B, C0/B0. CU diel s, s, D1 2 GI223/T 21 31T () pa48[a]. Bl: 1. OFF3
) Commlsspmrlﬁg Sl [ © pB48[1]. Bl: 1. OFF3
- O_Dmmun_lcann L © L8490, BL: 2 OFF3
=% Diagnostics 1 pE43[1], BI: 2 OFF3
- » Controlfstatus P | © T ,
" ] ¥ il Control_Unit, (722: Bit 3, CO/BO: CU digital inputs, status: : DI 3 (<122.4/121.4) [ O pB52[0). Bl: Enable operatio
| | O pBaZ[1]. Bl: Enable operatio
Commissioning Manual
102 Commissioning Manual, (IH1), 01/2011, 6SL3097-4AF00-0BP1



Commissioning

2.7 First commissioning, vector control mode in the chassis format

What to do? How to doit? Comment
4.3 Ramp-function ¢ Ramp-function generator See function diagram [3060]
generator
p1140 = 1 Ramp-function generator enable
p1141 = 1 Ramp-function generator start
p1142 = 1 Enable setpoint
=@ Drive_1 Bl/Cl | BO/CO |
""" ®) Insert DCC charts |- 5 © p1140[0], Bl: Enables the ran
-3 Drive navigator = © p114001], BI: Enables the ran
""" > Conﬁgura'agn }:|I1 O p1141[0]. BI: Start ramp-funcd
..... > Contral logic ) [ O p1141[1], BI: Start ramp-funcd
E-» Open-loopfclosed- | _
@ % Functions 1 O p1142[0]. Bl: Enable speed &
1142[1]. Bl: Enabl d
- Messages and mori b © BiLCENL B Sizelo cpe2sie
E-% Commissioning
E-% Communicaton
=% Diagnostics
> Confrolfstatus
----- bR [iter connection:
4.4 Setpoint e Specify setpoint A setpoint of 0 (0 signal) or 40 (1
. ] signal) is defaulted via digital input
p1001 = 0 Fixed setpoint 1 7. This setpoint is then applied to
p1002 = 40 Fixed setpoint 2 the main setpoint p1070.
See function diagram [3010]
p1020 = r0722 Fixed speed setpoint selection
r1024 = p1070 Fixed setpoint active
E@‘ Drive_1 Fized setpaints I Fixed setpoint interconnection |
8 Ingert DCC charts Bit D
¥ Drive navigator F|C0_5_fa7. 72z Bt v, C0/B0: CU (5 E
> Configuration Bit1
> Control logic EI'U —07
» Setpeint Channel Bit 2
> Motor potentiomety Ellj _O—
: Bit 3
o ‘OT
0.00 ] ]
Fised value 1 [ETNE RFM —p|ojo|1
z IU.UUU AP D (O |1 |
3 |n_nnn APM el O O] 1 [ 1
4 |n_nnn AFM i | 1|0 (O
2]/ I—
5 [0.000 o|1|o|1 —
£ |0.000 APM el O [ 1|1 | D _ _
- [oom P olilila Fized value effecl:twe
Q_.AA 1070[0]. CI: Main setp
a |0oo0 FPY  ———1|0]O]0
5. Load parameters to e Connect with target system (go online) Position cursor on drive unit and

device

Target device —> Load to target device

right-click.
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What to do? How to do it? Comment
6. Motor temperature Thermistor selection: via Motor Module (11)
Temperature sensor type: KTY84 (2)
Response to overtemperature: alarm and fault
(no reduction of Imax)
Fault message for thermistor failure: ON
Deceleration time: 0.100 s
Alarm threshold: 120.0° C
Fault threshold: 155.0° C
E||ﬁ| Dirive_1 tatar temnperature I
..... ) Insert DCC charts Thermistor selection
.ﬁ Dirive navigator Temperature encoder 1 [1]
..... > Conﬁguratiom Therrmnistar type
----- > Control logic [KkTve4 2 |
P Setpoint Chanrel Responze with overtemperature
- Oper-oo fC|OSE!d-| IWaming and fault [reduction of lmas] ;I
P i P Fault message for a thermistor failure
#-% Functons [fes |
=% Messages and moni
> Speed messages Fault message delay time IU-1 s
R otor temperaty
299°C
Enc. module
O—Waming messd

O_Fault message

7. Save the parameters
on the device

Target device -> Copy from RAM to ROM

Position cursor on drive unit and
right-click.

8. The motor starts to
run.

The drives can be started via the control panel in
STARTER.

e Line/DC link identification will be carried out once
the pulses for the infeed have been enabled and
line/DC link identification has been activated. The
infeed then switches to operational mode.

o When the pulses are enabled, a one-off motor
data identification run (if activated) is carried out.

e When the pulses are enabled again, optimization
with a rotating motor (if activated) is carried out.

For more information about the
control panel, see Getting Started.

During motor data identification, a
current flows through the motor,
which means that it can align itself
by up to a quarter of a revolution.

For more information about line/DC
link/motor data identification, see
the SINAMICS S120 Function
Manual.

Diagnostics parameters (see the SINAMICS S120/S150 List Manual)
e 10002 Infeed/drive operating display

® 10046 Missing enable signals (for more information, see "Diagnostics")
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2.8 First commissioning, control mode vector AC Drive in the booksize
format

The example provided in this section explains all the configuration and parameter settings,
as well as the tests that are required for initial commissioning. Commissioning is carried out
using the STARTER commissioning tool.

Requirements for commissioning
1. The commissioning requirements have been met according to Section 1.1.

2. The check list - Table 1-1 or 1-2 from the Chapter Preparing for commissioning - has
been filled out and the points complied with.

2.8.1 Task

1. A drive unit is to be commissioned (operating mode vector, closed-loop speed control),
without DRIVE-CLIiQ and without speed encoder with the following components:

Table 2- 14 Component overview

Designation Component Order number
Closed-loop control
Control Unit Control Unit 310-2DP 6SL3040-1LA00-0AAO
Operator Panel Basic Operator Panel BOP20 6SL3055-0AA00-4BAX
Infeed and drive
Power Module Power Module 340 6SL3210-1SB14-xxxx
Motor Induction motor 1LA7

(without DRIVE-CLIQ interface)

2. Commissioning is performed using the BOP20.

3. The function keys on the BOP20 must be parameterized so that the ON/OFF signal and
speed settings can be defined via these keys.
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28.2 Component wiring (example)

The following diagram shows a possible component configuration and wiring option.

L1
L2

L3
|

1

IIRTIR Xi00

Control
Unit
310-2

E|x124

Power Module 340

Line reactor @ Line filter
L

Motor cable

Figure 2-24  Component wiring (example)

For more information on wiring, see the Equipment Manual.

Commissioning Manual
106 Commissioning Manual, (IH1), 01/2011, 6SL3097-4AF00-0BP1



Commissioning
2.8 First commissioning, control mode vector AC Drive in the booksize format

2.8.3 Quick commissioning using the BOP (example)

Table 2- 15  Quick commissioning for a vector drive without a DRIVE-CLIQ interface

Procedure Description Factory
sefting |
Restore the drive to the factory setting:
1. p0009 = 30 Device commissioning parameter filter * 1
0 | Ready

1 | Device configuration

30 | Parameter reset
2. p0976 = 1 Reset and load all parameters 0

0 | Not active

1| Start restoring all parameters to their factory settings

Wait approx. 15 sec. When ready, the BOP display shows = 35 and the RDY-LED is green. PO009 is automatically set to
1, p0976 to 0.

Note:
As soon as the RDY-LED is green again, the factory setting has been completed and commissioning can start.
3. p0009 =1 Device commissioning parameter filter * 1

0 | Ready
1| Device configuration

30 | Parameter reset
4. p0097 =2 Select drive object type * 0
0 | No selection

1 | Drive object type SERVO
2 | Drive object type VECTOR
5. p0009 =0 Device commissioning parameter filter * 1
0 | Ready

1 | Device configuration

Note:
Wait approx. 10 sec. The basic configuration is saved once the RDY lights green. In order to transfer this state into ROM,

press the "p" until the display flashes. When the flashing stops, the RDY changes from orange to green and the transfer

has been completed. Alarm A07991 indicates that the motor data identification function has been activated at drive DO 2.
The drive parameters are entered:

6. DO =2 Select drive object (DO) = 2 (= VECTOR) 1
1| Expert list of the CU
2 | Expert list of the drive

To select a drive object (DO), simultaneously press the Fn key and the arrow up
key.
The selected drive object is displayed at the top left.

7. p0010 =1 Drive, commissioning parameter filter * 1
0 | Ready
1| Quick commissioning
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Procedure Description Factory
setting
8. p0100=0  |IEC/NEMA motor standard 0
0 | IEC motor (Sl units, e.g. kW)
Preset:

Rated motor frequency (p0310): 50 Hz
Specification of the power factor cos ¢ (p0308)

1 | NEMA motor (US units, e.g. hp)

Preset:
Rated motor frequency (p0310): 60 Hz
Specification of the efficiency (p0309)

Note:
When p0100 is changed, all the rated motor parameters are reset.

9. p030X[0] = ... | Rated motor data [MDS] -
Only when p0300 < 100 (third-party motor)
Enter the rated motor data in accordance with the rating plate, e.g.

p0304[0] | Rated motor voltage [MDS]

p0305[0] | Rated motor current [MDS]

p0307[0] | Rated motor output [MDS]

p0308[0] | Rated motor power factor [MDS] (only when p0100 = 0)
p0309[0] | Rated motor efficiency [MDS] (only when p0100 = 1)
p0310[0] | Rated motor frequency [MDS]

p0311[0] | Rated motor speed [MDS]

p0335[0] | Motor cooling type [MDS] *

0: Natural cooling
1: Forced cooling
2 Water cooling

10. p1900 = 2 Motor data identification and rotating measurement* 2
0 | Inhibited
1 | Motor data identification for rotating motor

2 | Motor data identification for a stationary motor

Message A07991 is displayed, motor data identification was activated.

Danger

During motor data identification, the drive may cause the motor to move. The EMERGENCY OFF functions
must be fully operational during commissioning. To protect the machines and personnel, the relevant safety
regulations must be observed.

Operation is configured:

11. p0010=0 Drive, commissioning parameter filter * 1
0 | Ready
1 | Quick commissioning

RDY is lit red, fault FO7085 signals that a control parameter has been changed.
12. p0840[0] = Bl: ON/OFF1 [CDS] 0

r0019.0(DO 1) | sets the signal source for STW1.0 (ON/OFF1)

Interconnection with r0019.000 of the drive object Control Unit (DO 1)

Effect: Signal ON/OFF1 from the BOP
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Procedure Description Factory
setting |
13. p1035[0] = BI: Motor potentiometer setpoint higher [CDS] 0

r0019.0013 Sets the signal source to increase the setpoint for the motorized potentiometer
(GO Interconnection with r0019.013 of the drive object Control Unit (DO 1)

Effect: Signal, motorized potentiometer setpoint higher from BOP

14. p1036[0] = BI: Motor potentiometer setpoint lower [CDS] 0

r0019.0014 Sets the signal source to reduce the setpoint for the motorized potentiometer

(BO1) Interconnection with r0019.014 of the drive object Control Unit (DO 1)
Effect: Signal, motorized potentiometer lower setpoint from BOP

15. p1070[0] = CI: Main setpoint [CDS] 0
r1050 (DO 63) | sets the signal source for speed setpoint 1 of the speed controller.

Interconnection with r1050.000 to the separate drive object (DO 63)
Effect: Motorized potentiometer supplies the speed setpoint

16. | "FN", then press "P". The display indicates 41, press "O", the display jumps to 31.

17. | Start the motor data identification with
41.

18. | 31 is displayed again after pressing "O", the drive is now ready. The drive is switched on by pressing "I", the motor
accelerates by pressing the "arrow up" key.

. The drive switches off again after approx. 5 sec. the display goes back to

19. | Saveall Press the P key for approx. 5 sec until the display flashes.
parameters

* These parameters offer more setting options than the ones described here. For further setting options see
SINAMICS S120/S150 List Manual

[CDS] Parameter depends on command data sets (CDS). Data set 0 is preset.
[DDS] Parameter depends on drive data sets (DDS). Data set 0 is preset.
[MDS] Parameter depends on motor data sets (MDS). Data set 0 is preset.

Bl binector input

BO binector output

ClI connector input

CO connector output
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2.9 First commissioning, control mode servo AC Drive in the booksize
format
2.9.1 Initial commissioning using servo (booksize) as an example_lead text

The example provided in this section explains all the configuration and parameter settings,
as well as the tests that are required for initial commissioning. Commissioning is carried out
using the STARTER commissioning tool.

Requirements for commissioning
1. The commissioning requirements have been met according to Section 1.1.

2. The check list - Table 1-1 or 1-2 from the Chapter Preparing for commissioning - has
been filled out and the points complied with.

29.2 Task

1. A drive unit should be commissioned (operating mode servo, closed-loop speed control)
with the following components:

Table 2- 16 Component overview

Designation Component Order number

Closed-loop control

Control Unit Control Unit 310-2DP 6SL3040-1LA00-0AAQ

Operator Panel Basic Operator Panel 20 6SL3055-0AA00-4BAX
(BOP20)

Infeed and drive

Power Module Power Module 340 6SL3210-XxxxX-XXXX

Motor Synchronous motor with DRIVE- | 1FK7061-7AF7x—xAxx
CLiQ interface

Motor encoder via DRIVE-CLiIQ | Incremental encoder sin/cos TFK7XXX=XXXXX—XAXX
C/D

1 Vpp 2048 pir

1. Commissioning is performed using the BOP20.

2. The Basic Operator Panel (BOP) should be parameterized so that the ON/OFF signal
and the speed setpoints are entered using the function keys.
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293 Component wiring (example)

The following diagram shows a possible component configuration and wiring option.

L1
L2

L3
|

DRIVE-CLIQ

r
IRIINIL X100

Control
Unit
310-2 DP

Hx124

Power Module 340

Line reactor @ Line filter
1L

Motor cable

Figure 2-25 Component wiring with integrated Sensor Module (example)

For more information on wiring and connecting the encoder system, see the Equipment
Manual.
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294

Table 2- 17 Quick commissioning of a servo drive with a DRIVE-CLIiQ interface

Quick commissioning using the BOP (example)

Procedure Description Factory
setting
Note:
Before commissioning for the first time, in the drive mode DO = 1, the drive is restored to the factory setting.
1. p0009 = 30 Device commissioning parameter filter 1
0 | Ready
1 | Device configuration
30 | Parameter reset
2. p0976 =1 Reset and load all parameters 0
0 | Not active
1 | Start restoring all parameters to their factory settings
Note:
As soon as the RDY-LED is green again, the factory setting has been established and commissioning can start.
3. p0003 = 3 Access levels 1
1| Standard
2 | Extended
3 | Expert
4. p0009 =1 Device commissioning parameter filter * 1
0 | Ready
1 | Device configuration
30 | Parameter reset
5. p0097 =1 Select drive object type * 0
0 | No selection
1| Drive object type SERVO
2 | Drive object type VECTOR
6. p0009 =0 Device commissioning parameter filter * 1
0 | Ready
1 | Device configuration
30 | Parameter reset
Note:
For the firmware to be activated, a POWER ON must be carried out for the components.
The extended setpoint channel must be opened for motorized potentiometer simulation with p0108[1] = H0104
7. p0009 = 2 Device commissioning parameter filter * 1
0 Ready
1 Device configuration
2 Defining the drive type / drive options
30 Parameter reset
8. p0108[1] = Drive object, function module * H0000
HO104 Bit 2 | Closed-loop speed/torque control
Bit 8 | Extended setpoint channel
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Procedure Description Factory
setting
9. p0009 = 0 Device commissioning parameter filter * 1
0 | Ready

1| Device configuration

30 | Parameter reset

Note:

Wait until the RDY-LED changes from orange to green. To save the setting in the ROM, press about 5 seconds on the "P"
key until the BOP display flashes, then wait until flashing has stopped. The drive is now prepared.

10. DO =2 Select drive object (DO) 2 (= SERVO) 1
1| Expert list of the CU
2 | Expert list of the servo drive

To select a drive object (DO), simultaneously press the Fn key and the "Arrow up"

key.

The selected drive object is displayed at the top left.

11. p0840[0] = Bl: ON/OFF1 [CDS] 0

r0019.0(DO 1) | sets the signal source for STW1.0 (ON/OFF1)

Interconnection with r0019.0 of the drive object Control Unit (DO 1)

Effect: Signal ON/OFF1 from the BOP

12. p1035[0] = Bl: Motor potentiometer setpoint higher [CDS] 0

r0019.0013 Sets the signal source to increase the setpoint for the motorized potentiometer
(Bo1) Interconnection with r0019.13 of the drive object Control Unit (DO 1)

Effect: Signal, motorized potentiometer setpoint higher from BOP

13. p1036[0] = BI: Motor potentiometer setpoint lower [CDS] 0

r0019.0014 Sets the signal source to reduce the setpoint for the motorized potentiometer

(Bo1) Interconnection with r0019.14 of the drive object Control Unit (DO 1)
Effect: Signal, motorized potentiometer lower setpoint from BOP
14. p1037 = 6.000 | Max. speed, setpoint potentiometer 0.000
15. p1070[0] = Cl: Main setpoint [CDS] 1024

r1050 (DO 63) | sets the signal source for speed setpoint 1 of the speed controller.
Interconnecting to r1050 on its own drive object (DO 63)

Effect: Motorized potentiometer supplies the speed setpoint

16. p0006 =0 BOP operating display mode* 4
0 | Operation ->r0021, otherwise r0020 <-> r0021
1| Operation -> r0021, otherwise r0020

2 | Operation -> p0005, otherwise p0005 <-> r0020
3 | Operation -> r0002, otherwise r0002 <-> r0020
4 | p0005

"FN", then press "P", the display in DO = 2 displays 31.
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Procedure Description Factory

setting

17. | Save all

parameters

Press the "P" key for approx. 5 sec, 41 is displayed. After pressing the "O" key, the display
jumps to 31 - and the drive is now ready. 10 is displayed in DO = 1.

Bl binector input

BO binector output
CI connector input
CO connector output

* These parameters offer more setting options than the ones described here. For further setting options see
SINAMICS S120/S150 List Manual

[CDS] Parameter depends on command data sets (CDS). Data set 0 is preset.
[DDS] Parameter depends on drive data sets (DDS). Data set 0 is preset.

210

114

Commissioning of power units connected in parallel

During commissioning, power units connected in parallel are treated like a power unit on the
line or motor side. With parallel connection, the parameter display for the actual values
changes only slightly. Suitable "total values" are derived from the individual values of the
power units.

For parallel connection only

® chassis type infeeds

® chassis type Motor Modules in vector control mode
may be used.

During first commissioning of power units the parallel connection is activated using the
wizard in STARTER. You can also select parallel connection as an option (see following
diagrams) when choosing the power unit (infeed and/or Motor Module).
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Parallel connection of infeeds in STARTER

Infesd: Infead

¥ Line/DC-link identification ak first switch-on
Caution:
The determined values are stored safely agamst power loss.
IF the powees supply or the DC link (removal/adding of devices] of

the diive line-up is subsequently changed, an identfication must be
petformed again.

Device connaction voltage: 400 WV  3phase AC 50-80 Hz

Al F 400V 132 KW 160 ki [BSLA300-7TE 32-B4x0) [10]

v Parallel connection nfeed (BSL3330-7TE32-144x - 132 kiw)
Numberof parallel moddes i |

= Woltage sensrmg module svailatle
Numter of Yahs [ 3

[ Braking Module extemnal

I~ Master/Slave

< Back Newt> Cancel | Hep |

Figure 2-26 Example of parallel connection of 3 Active Line Modules (chassis type)

You need to specify the number of infeeds to be connected in parallel in the appropriate field
(maximum 8 infeeds).

You can also choose possible Master/Slave function for the Active Line Modules using an
option on this screen (see SINAMICS S120 Function Manual, chapter "Master/slave function
for infeeds").

The line filter is offered as an option, depending on the infeed. An Active Interface Module
(AIM) with integrated line filter is required to operate an "Active Line Module" (ALM). We
recommend external line filters to operate the "Basic Line Module" (BLM) and "Smart Line
Module" (SLM) infeeds.
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Parallel connection of Motor Modules in STARTER

116

[W]0ption ma: Drve: Divve_1.0D5 0
W] inzert in
[¥linieed canfic Power_unit
Order na. | Code rumber |
BSL3320-1 TE32-1 b 14501
{+ Nojfker/choke Caution: If a sinusaidal fiter is
" Simusoidal il used, it must be selected,
e /YN Otheiwise the sinusoidai e wil
" Dutput choke be destroyed!
" dvielt filker with VPL
Iv Pl connection
Murnber of parallel modules
|3 Mumber of power modules connected in parallel j

<Back Nest> Cancel | Heo |

Figure 2-27 Example of parallel connection of 3 Motor Modules (chassis type, vector control)

You need to specify the number of Motor Modules to be connected in parallel in the
appropriate field (maximum 8 Motor Modules).

NOTICE

For parallel connection, SIEMENS only enables the operation of a maximum of 8 power
units connected in parallel (for a maximum of 4 infeeds and a maximum of 4 Motor
Modules).
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Configuration of parallel connections using parameters

From the point of view of a higher-level PLC, the parallel connection of infeeds behaves like
the activation of a single infeed, with the running total outputs of the individual infeeds.

A connection via PROFIdrive telegrams permits the power units to be individually activated
and their status queried using parameter services from a higher-level controller. Infeeds may
also be activated using the appropriate control and status words. These are documented in
the chapter "Communication according to PROFIdrive" in the SINAMICS S120 Drive
Functions Function Manual.

Power units should only be activated and deactivated if an error occurs, that is when a power
unit fails and must be exchanged. This approach is unsuitable for variable power control, as
the drive line-up control parameters need to be recalculated after every firmware change, for
instance when the drive line-up is commissioned. Optimal, highly dynamic control behavior
of the drive line-up can only be ensured by recalculation.

The power units can be monitored and parameterized individually:
via the individual parameters p0125..p0128, p0895, r7000, p7001ff:

® Parameter p0125[0...n] "activate/deactivate power unit components" permits targeted
activation or deactivation of a power unit in the topology (choice via the topology
number).

e With p0895[0...n] Bl: power unit components, a power unit is activated or deactivated
using an interconnected digital input (BI).

® The number of currently active power units connected in parallel can be displayed by
parameter r7000.

® After an error or exchange of units, parameter p7001[0...n] (Par_circuit enable power
units) allows targeted activation or deactivation of connected power units.

You can still cancel alarms in this state (due to overtemperatures for example). Individual
power units cannot be disabled for motors with separate winding systems (p7003 = 1).
p7001 is reset automatically if a power unit is deactivated with p0125 or p0895.

® You can use parameter r7002[0..n] to query whether the pulse in a power unit is inhibited
or enabled.

e Parameters r7050[0..n], r7051[0..n] and r7052[0..n] can be used to display the circuit
currents for U, V, W on the power units.

e Overload states and various temperature states in the power units can be displayed with
parameters from r7200[0..n] onwards.

Parallel connection is indicated with a "P" in front of the value shown on the parameter value
display.

You can find out more about other parameters relevant for the operation and
parameterization of power units in the references: SINAMICS S$120/S150 List Manual from
parameter r7002ff or p0125 onwards.
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Parallel connection with one or two Control Units

If an infeed is deactivated, the pre-charging must be able to charge the rest of the infeeds in
the DC link. E.g. The pre-charging time is doubled when only one infeed is available instead
of previously two infeeds in parallel. If possible, the infeeds should be dimensioned such that
one infeed, or with redundant interconnection (2 Control Units), one subsystem is able to
pre-charge the whole DC link.

The connected capacitance should not be too large. However, pre-charging double an
infeed's rated capacitance (one of two infeeds previously out of operation) will work with no
problems.

Pre-charging contactor monitoring

To monitor pre-charging contactors (for infeed failure), auxiliary terminal blocks must be
retrospectively connected to the pre-charging contactors.

The following diagram shows the basic concept of interconnection:
Pre-charging

Infeed 1 Infeed 2 Infeed 3

13/|—14 13/|—14 13 /|,14 . Opening delay 1's
>=1 TI]--]0
21 22 21 22 21 22 ext. fault
+24 V

additional terminal blocks on pre-charging contactors

Figure 2-28 Pre-charging monitoring

The contactor states are monitored using the logic blocks "free blocks" in the SINAMICS
drive. If one of the contactors does not pick up, an external fault message is generated.
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Operating state of power units connected in parallel

Fault messages and alarms from A05000ff or FO5000ff onwards indicate errors in a power
unit.

Power unit faults are stored in the fault buffer in the appropriate Control Unit and can be read
as a fault value using parameter r0949 (interpreted decimally). This fault value corresponds
to the drive object number in the drive line-up topology. The number of the fault occurring is
stored in parameter r0945.

The power unit's operating state (infeed or Motor Module) is displayed at both front LEDs on
the corresponding Control Interface Module (CIM).

You can identify the power unit for a particular drive using parameter p0124[0...n] "Power
unit detection via LED". During p0124 = 1, the LED READY on the power unit concerned
flashes green/orange or red/orange at 2 Hz. For parallel connections the parameter index is
assigned to one power unit in each case.

Configuration of power units connected in parallel

2.1

Description

Information on the hardware configuration and wiring the power units is provided in the
SINAMICS S120 Equipment Manual Chassis Power Units.

You can find information on configuration in "SINAMICS Configuration Manual G130, G150,
S120 Chassis, S120 Cabinet Modules, S150". The installation of power units within a control
cabinet with Line Connection Modules is also described there.

Learn devices

Using a software update, the "learning devices" function amends an existing STARTER
(from version V4.2) with information about later drive firmware versions.

The update is implemented with a SINAMICS Support Package (SSP) from STARTER
version 4.2. In STARTER, equipment descriptions are added to without changing the code or
newly installing STARTER, and without the drive being physically available.

A SINAMICS Support Package must be installed if SINAMICS STARTER versions that are
not covered by STARTER version 4.2 need to be supported. You can download SINAMICS
Support Packages on the Internet from the eSupport and Product Support pages.

The existence of new SSPs in Product Support will be announced when a new SINAMICS

version is released for delivery.

Commissioning Manual
Commissioning Manual, (IH1), 01/2011, 6SL3097-4AF00-0BP1 119



Commissioning

2. 12 Selection and configuration of encoders

SSP (SINAMICS Support Package)

212

An SSP contains only description files of the devices and drive objects. By installing an SSP,
new drive objects and devices can be added to an existing STARTER installation, without
changing its program code.

After installation, all the functions of the new SINAMICS version can be configured with the
expert list. All screens and wizards are also available for all the functions compatible with the
previous version.

SSP content:

e New drive objects

® New device versions

® New and changed parameters in the expert list

® New and changed faults, alarms and messages

¢ New and changed sequence parameterizations

® Expansions of the component catalog (new motors, encoders, DRIVE-CLiIQ components)
® Expansion of the configuration catalog (SD)

® (Changed online help files (parameter help, function diagrams)

Installation
All SSPs released for a STARTER version may be installed in any order.

The installed SINAMICS Support Packages are displayed in the Info dialog box of
STARTER.

If a new STARTER version has been created and delivered, this STARTER contains all
SSPs released up until the present time, or is compatible with them.

Compatible SSPs can also be installed a multiple number of times if repairs are necessary,
without functional changes.

STARTER should not be running during SSP installation. The installation program should be
started and run through. Only after the installation has been finished and STARTER has
been called up again, can you now configure the newly installed SINAMICS versions offline
and operate them online (via "Accessible nodes" for example).

Selection and configuration of encoders

Encoder selection

120

For SINAMICS drives there are three possibilities of selecting the encoder using STARTER:

1. Evaluating the motor and encoder data via a DRIVE-CLIQ interface.
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The encoder is automatically identified by setting the parameter p0400 = 10000 or 10100,
i.e. all of the motor and encoder data required for the configuration are read out of the
encoder. For p0400 = 10100, the identification time is not limited.

2. Select a standard encoder from a list (also possible via the motor order number for
encoder 1/motor encoder). Every encoder type on the list has a code number (see
SINAMICS S120/S150 List Manual), that can also be assigned using parameter p0400
(encoder type selection).

3. Manually entering user-defined encoder data. The user himself can configure the encoder
using the encoder-specific STARTER screens.

The encoders can also be configured on their own using parameters (parameter p0400, ff).

Table 2- 18  Assigning encoder type, encoder code and evaluation modules for standard encoders

Encoder type Encoder code | Encoder evaluation procedure Evaluation module
Resolver Incremental 1001 Resolver 1-speed SMC10, SMI10
rotary 1002 Resolver 2-speed
1003 Resolver 3-speed
1004 Resolver 4-speed
Encoder with | Incremental 2001 2048, 1 Vpp, AIB C/D R SMC20, SMI20,
sin/cos 1Vpp | encoder 2002 2048, 1 Vpp, AABBR SME20, SME120
rotary 2003 256, 1 Vpp, AABBR
2005 512, 1 Vpp, AIBR
2010 18000, 1 Vpp, A/B R distance-coded
EnDat Absolute value 2051 2048, 1 Vpp, A/B, EnDat, multiturn 4096 SMC20, SMI20,
encoder rotary 2052 32, 1 Vpp, A/B, EnDat, multiturn 4096 SME25
2053 512, 1 Vpp, A/B, EnDat, multiturn 4096
2054 16, 1 Vpp, A/B, EnDat, multiturn 4096
2055 2048, 1 Vpp, A/B, EnDat, singleturn
SSl encoder | Absolute value 2081 2048, 1 Vpp, A/B, SSI, singleturn SMC20, SMI20,
with rotary 2082 2048, 1 Vpp, A/B, SSI, multiturn 4096 SME25, SME125
sin/cos 1Vpp 2083 2048, 1 Vpp, A/B, SSI, singleturn, error bit
2084 2048, 1 Vpp, A/B, SSI, multiturn 4096, error
bit
Linear Incremental 2110 4000 nm, 1 Vpp, A/B R distance-coded SMC20, SMI20,
encoder linear 2111 20000 nm, 1 Vpp, A/B R distance-coded SME20
2112 40000 nm, 1 Vpp, A/B R distance-coded
2151 16000 nm, 1 Vpp, A/B, EnDat, resolution
100 nm
Absolute value 2151 16000 nm, 1 Vpp, A/B, EnDat, SMC20, SMI20,
linear resolution 100 nm SME25
HTL/TTL Incremental 3001 1024 HTL A/BR SMC30
encoders right angle 3002 1024 TTLA/BR
rotary 3003 2048 HTL A/BR
3005 1024 HTL A/B
3006 1024 TTL A/B
3007 2048 HTL A/B
3008 2048 TTL A/B
3009 1024 HTL A/B unipolar
3011 2048 HTL A/B unipolar
3020 2048 TTL A/B R, with Sense
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Encoder type Encoder code | Encoder evaluation procedure Evaluation module
SSl encoder | Absolute value 3081 SSlI, singleturn, 24 V SMC20, SMI20,
absolute rotary 3082 SSI, multiturn 4096, 24 V SME25, SME125
Not for motor control,
only as a direct measurement system
SSl encoder | Absolute value 3090 4096, HTL, A/B, SSI, singleturn SMC30
absolute HTL | rotary
Linear Incremental 3109 2000 nm, TTL, A/B R distance-coded SMC20, SMI20,
encoder linear SME20
DRIVE-CLiQ | Absolute rotary 202 Abs.,singleturn 20 bit -
encoder value 242 abs.,singleturn 24 Bit
204 abs.,multiturn 12 bit, singleturn 20 bit)
244 abs.,multiturn 12 bit, singleturn 24 bit)
SIMAG H2 Incremental 2002 2048, 1 Vpp, AABBR SMC20, SMI20,
encoder 2003 256, 1 Vpp, AABBR SME20
rotary 2004 400, 1 Vpp, AIBR
2005 512, 1 Vpp, AIBR
2006 192, 1 Vpp, AIBR
2007 480, 1 Vpp, AIBR
2008 800, 1 Vpp, AIBR
Encoder configuration
You can configure the encoders using a screen in STARTER.
1. If you mark the appropriate checkbox option, encoders with a DRIVE-CLIiQ interface are
automatically identified on the encoder configuration screen.
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2. 12 Selection and configuration of encoders

Configuration - SINAMICS_S120_CU320 - Encoder

Figure 2-29 Identifying DRIVE-CLIiQ encoders
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2.12 Selection and configuration of encoders

2. You can select standard encoders from a list. The encoder 1 / motor encoder 